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Q.1 A and B working together can do a piece of work in 6 days. B alone can do the same
work in 15 days. How long (in days) will A alone take to do thrice the work?2561

Ans 1. 90

2. 30

3. 60

4. 120

Question Type : MCQ

Question ID : 441009518845

Option 1 ID : 4410092030801

Option 2 ID : 4410092030799

Option 3 ID : 4410092030800

Option 4 ID : 4410092030802

Status : Answered

Chosen Option : 2

Q.2 Sachin purchased 10 kg of rice at the rate of ₹36 per kg and 32 kg of rice at ₹46 per
kg. He sold the whole mixture at the rate of ₹42.5 per kg. Find his loss (in ₹).

Ans 1. 42

2. 52

3. 47

4. 55

Question Type : MCQ

Question ID : 441009277557

Option 1 ID : 4410091078189

Option 2 ID : 4410091078188

Option 3 ID : 4410091078187

Option 4 ID : 4410091078190

Status : Answered

Chosen Option : 3
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Q.3 What sum of money (in ₹) will amount to ₹4800 at 4% per annum simple interest in 5
years?6930

Ans 1. 4050

2. 4000

3. 24000

4. 3950

Question Type : MCQ

Question ID : 441009570504

Option 1 ID : 4410092237138

Option 2 ID : 4410092237136

Option 3 ID : 4410092237139

Option 4 ID : 4410092237137

Status : Answered

Chosen Option : 3

Q.4 A, B and C started a business with their investment in the ratio of 2 :
3 : 4. Find the difference between the share of B and share of C from
the total annual profit of ₹46,800.

Ans 1. ₹5,300

2. ₹5,500

3. ₹5,100

4. ₹5,200

Question Type : MCQ

Question ID : 441009339773

Option 1 ID : 4410091325128

Option 2 ID : 4410091325129

Option 3 ID : 4410091325126

Option 4 ID : 4410091325127

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.5

Ans 1. 25.12

2. 50.42

3. 25.21

4. 50.24

Question Type : MCQ

Question ID : 4410091758514

Option 1 ID : 4410096934199

Option 2 ID : 4410096934198

Option 3 ID : 4410096934200

Option 4 ID : 4410096934197

Status : Answered

Chosen Option : 1

Q.6 There are 180 boys and 240 girls. The teacher wants to arrange them in such a way
that each row has the same number of students, with only boys or only girls in a row.
What is the maximum number of students that can be in each row?

Ans 1. 80

2. 30

3. 60

4. 20

Question Type : MCQ

Question ID : 44100910848

Option 1 ID : 44100943177

Option 2 ID : 44100943175

Option 3 ID : 44100943174

Option 4 ID : 44100943176

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.7 Two parallel chords are drawn in a circle of diameter 20 cm. The length of one chord
is 16 cm and the distance between the two chords is 12 cm. Find the length (in cm)
of the other chord.

Ans 1. 12

2. 16

3. 10

4. 14

Question Type : MCQ

Question ID : 441009592599

Option 1 ID : 4410092325514

Option 2 ID : 4410092325516

Option 3 ID : 4410092325513

Option 4 ID : 4410092325515

Status : Answered

Chosen Option : 2

Q.8 A car can travel 600 km in a full tank of petrol, whose capacity is 48 liters. Find the
distance travelled by car with 31 liters of petrol.

Ans 1. 390.0 km

2. 377.2 km

3. 387.5 km

4. 385.5 km

Question Type : MCQ

Question ID : 4410091002123

Option 1 ID : 4410093960206

Option 2 ID : 4410093960205

Option 3 ID : 4410093960203

Option 4 ID : 4410093960204

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.9 A shopkeeper fixes the marked price of an item 70% above its cost price. What
percentage of discount on marked price should be allowed to gain 19%?346

Ans 1. 28%

2. 33%

3. 29%

4. 30%

Question Type : MCQ

Question ID : 441009577250

Option 1 ID : 4410092264129

Option 2 ID : 4410092264127

Option 3 ID : 4410092264128

Option 4 ID : 4410092264126

Status : Answered

Chosen Option : 4

Q.10 Manish's average earning per month in the first three months of a year was ₹39416.
In April, his earning was 50% more than the average earning in the first three
months. If his average earning per month for the whole year is ₹58939, then what
will be Manish's average earning (in ₹) per month from May to December?5917

Ans 1. 66237

2. 66240

3. 66242

4. 66235

Question Type : MCQ

Question ID : 441009582821

Option 1 ID : 4410092286410

Option 2 ID : 4410092286411

Option 3 ID : 4410092286413

Option 4 ID : 4410092286412

Status : Answered

Chosen Option : 2
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Q.11 A shopkeeper offers a scheme: ‘Buy 26 chocolates and get 4 chocolates free’. What
is the effective discount percentage equivalent to this scheme?

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ

Question ID : 4410091758449

Option 1 ID : 4410096933944

Option 2 ID : 4410096933943

Option 3 ID : 4410096933942

Option 4 ID : 4410096933941

Status : Answered

Chosen Option : 2

Q.12 Aman can complete a job in 28 days, while Ravi can complete the same job in 49
days. If both work together, how many days will they take to finish the work?

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ

Question ID : 4410091762285

Option 1 ID : 4410096949142

Option 2 ID : 4410096949144

Option 3 ID : 4410096949143

Option 4 ID : 4410096949141

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Q.13 Three numbers are in the ratio 4 : 7 : 11, and their LCM is 3696. Their HCF is:8567

Ans 1. 9

2. 61

3. 15

4. 12

Question Type : MCQ

Question ID : 441009524851

Option 1 ID : 4410092054826

Option 2 ID : 4410092054824

Option 3 ID : 4410092054825

Option 4 ID : 4410092054823

Status : Answered

Chosen Option : 4

Q.14 The volume of a cuboid is 3150 cm³. Its length is 28 cm and breadth is 15 cm. Find
its height (in cm).

Ans 1. 7

2. 8.5

3. 8

4. 7.5

Question Type : MCQ

Question ID : 4410091762711

Option 1 ID : 4410096950839

Option 2 ID : 4410096950842

Option 3 ID : 4410096950841

Option 4 ID : 4410096950840

Status : Answered

Chosen Option : 4
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Q.15 A boat travels 60 km downstream and 60 km upstream in 16 hours. If the speed of
the stream is 2 km/h, what is the speed of the boat (in km/h) in still water?

Ans 1. 12

2. 9

3. 8

4. 10

Question Type : MCQ

Question ID : 4410091758406

Option 1 ID : 4410096933772

Option 2 ID : 4410096933770

Option 3 ID : 4410096933769

Option 4 ID : 4410096933771

Status : Answered

Chosen Option : 3

Q.16 What smallest number should be added to 86072 so that the sum is completely
divisible by 80?2840

Ans 1. 11

2. 9

3. 8

4. 10

Question Type : MCQ

Question ID : 441009560251

Option 1 ID : 4410092196273

Option 2 ID : 4410092196272

Option 3 ID : 4410092196271

Option 4 ID : 4410092196274

Status : Answered

Chosen Option : 3
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Q.17 A boat takes 3 hours to travel 24 km downstream and 8 hours to travel 16 km
upstream. What is the speed (in km/h) of the stream?

Ans 1. 3

2. 1

3. 2

4. 4

Question Type : MCQ

Question ID : 4410091758397

Option 1 ID : 4410096933735

Option 2 ID : 4410096933733

Option 3 ID : 4410096933734

Option 4 ID : 4410096933736

Status : Answered

Chosen Option : 1

Q.18 Which of the options below is equivalent to 729x3 + 1331y3 + 2673x2y + 3267xy2?

Ans 1. (9x + 14y)3

2. (9x + 11y)3

3. (11x + 9y)3

4. (9x + 13y)3

Question Type : MCQ

Question ID : 4410091124014

Option 1 ID : 4410094431620

Option 2 ID : 4410094431617

Option 3 ID : 4410094431618

Option 4 ID : 4410094431619

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Q.19 If the compound interest on a sum of ₹y at 10% per annum compounded annually for
2 years is ₹735, then the total amount payable at the end of the two-year period will
be _________.

Ans 1. ₹3868

2. ₹4568

3. ₹3913

4. ₹4235

Question Type : MCQ

Question ID : 441009571627

Option 1 ID : 4410092241629

Option 2 ID : 4410092241630

Option 3 ID : 4410092241631

Option 4 ID : 4410092241628

Status : Answered

Chosen Option : 4

Q.20 In what ratio must a grocer mix two varieties of rice worth ₹49 per kg and ₹119 per
kg so that if he sells the mixture at ₹144 per kg he may gain 60%?

Ans 1. 31:42

2. 30:43

3. 31:44

4. 29:41

Question Type : MCQ

Question ID : 441009580104

Option 1 ID : 4410092275544

Option 2 ID : 4410092275543

Option 3 ID : 4410092275545

Option 4 ID : 4410092275542

Status : Not Answered

Chosen Option : --

https://applink.adda247.com/d/uHd24maK7j
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Q.21 The sum of the present ages of a father and his son is 15 years more than 3 times
the present age of the son. After 5 years from now, 2 times the father's age will be
10 years less than 5 times the son's age. The difference (in years) between the ages
of the father and the son is:

Ans 1. 44

2. 35

3. 40

4. 32

Question Type : MCQ

Question ID : 4410091221679

Option 1 ID : 4410094820141

Option 2 ID : 4410094820140

Option 3 ID : 4410094820139

Option 4 ID : 4410094820142

Status : Answered

Chosen Option : 3

Q.22 The current population of a town is 16425. It increases by 20% and 60% in two
successive years but decreases by 25% in the third year. What is the population of
the town at the end of the third year?8053

Ans 1. 23653

2. 23652

3. 23662

4. 23644

Question Type : MCQ

Question ID : 441009859335

Option 1 ID : 4410093390314

Option 2 ID : 4410093390312

Option 3 ID : 4410093390315

Option 4 ID : 4410093390313

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Q.23 What is the correct ascending order of the following ratios: 5:11, 7:9, 31:33, 25:27?

Ans 1. 5:11, 25:27, 7:9, 31:33

2. 5:11, 7:9, 25:27, 31:33

3. 7:9, 5:11, 25:27, 31:33

4. 5:11, 7:9, 31:33, 25:27

Question Type : MCQ

Question ID : 4410091758482

Option 1 ID : 4410096934072

Option 2 ID : 4410096934069

Option 3 ID : 4410096934070

Option 4 ID : 4410096934071

Status : Answered

Chosen Option : 2

Q.24 What is the value of the following expression?

cot 22° × cot 43° × cot 45° × cot 47° × cot 68°

Ans 1. 3

2. 0

3. −1

4. 1

Question Type : MCQ

Question ID : 441009592742

Option 1 ID : 4410092326086

Option 2 ID : 4410092326087

Option 3 ID : 4410092326085

Option 4 ID : 4410092326088

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.25 In a competitive examination, Ramu scores 86 marks in Mathematics and 78 marks
in Statistics, each out of 100. If the weight assigned to Mathematics is 1 and the
weight assigned to Statistics is 3, then what is Ramu’s weighted average score?

Ans 1. 82

2. 80

3. 81

4. 79

Question Type : MCQ

Question ID : 4410091758416

Option 1 ID : 4410096933812

Option 2 ID : 4410096933810

Option 3 ID : 4410096933811

Option 4 ID : 4410096933809

Status : Answered

Chosen Option : 2

Q.26

Ans 1. -79x + 57

2. 79x -57

3. 79x + 57

4. -79x -57

Question Type : MCQ

Question ID : 4410091226902

Option 1 ID : 4410094841091

Option 2 ID : 4410094841092

Option 3 ID : 4410094841094

Option 4 ID : 4410094841093

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.27 The equation ax2 + bx + c = 0 has imaginary roots. The constants a, b and c are three
consecutive natural numbers. We may take a, b and c in ascending or descending
order, the roots are still imaginary. What can be the smallest value of a?

Ans 1. 1

2. 2

3. 4

4. 3

Question Type : MCQ

Question ID : 4410091226443

Option 1 ID : 4410094839256

Option 2 ID : 4410094839257

Option 3 ID : 4410094839255

Option 4 ID : 4410094839258

Status : Answered

Chosen Option : 2

Q.28 What is the minimum value that must be assigned to A so that the 8-digit number
447A3439 is divisible by 11?

Ans 1. 3

2. 2

3. 4

4. 0

Question Type : MCQ

Question ID : 441009833491

Option 1 ID : 4410093287080

Option 2 ID : 4410093287082

Option 3 ID : 4410093287081

Option 4 ID : 4410093287083

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.29 The present cost of a plot area is ₹1,51,726. After a year, its cost increased to
₹1,96,537. The percentage increase (rounded off to the nearest integer) in the cost
of the plot area is:

Ans 1. 43%

2. 28%

3. 30%

4. 35%

Question Type : MCQ

Question ID : 441009237565

Option 1 ID : 441009928629

Option 2 ID : 441009928631

Option 3 ID : 441009928628

Option 4 ID : 441009928630

Status : Answered

Chosen Option : 2

Q.30 Evaluate: [(4 × 2) − (12 ÷ 6)] + 8

Ans 1. 15

2. 13

3. 16

4. 14

Question Type : MCQ

Question ID : 441009835962

Option 1 ID : 4410093296966

Option 2 ID : 4410093296965

Option 3 ID : 4410093296967

Option 4 ID : 4410093296964

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.31 If the sum of roots of 4x² - kx + 12 = 0 is 5, find the value of k.

Ans 1. 10

2. 20

3. 15

4. 16

Question Type : MCQ

Question ID : 4410091075477

Option 1 ID : 4410094239399

Option 2 ID : 4410094239402

Option 3 ID : 4410094239400

Option 4 ID : 4410094239401

Status : Not Answered

Chosen Option : --

Q.32 Let C be a circle with centre O and PQ be an arc on C which is 10 cm long. If the
circumference of the circle is 120 cm, find the angle made by the arc PQ at O.

Ans 1. 18°

2. 30°

3. 25°

4. 28°

Question Type : MCQ

Question ID : 441009280532

Option 1 ID : 4410091090089

Option 2 ID : 4410091090088

Option 3 ID : 4410091090090

Option 4 ID : 4410091090087

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Q.33 Three numbers x, y, and z are such that x:y =2:5, y:z = 6:7 and x + y + z = 308. What
is the fourth proportional of these three numbers?

Ans 1. 350

2. 340

3. 335

4. 345

Question Type : MCQ

Question ID : 4410091756969

Option 1 ID : 4410096928488

Option 2 ID : 4410096928486

Option 3 ID : 4410096928485

Option 4 ID : 4410096928487

Status : Answered

Chosen Option : 1

Q.34

Ans 1. 48.125

2. 48.25

3. 48.375

4. 48.5

Question Type : MCQ

Question ID : 4410091762729

Option 1 ID : 4410096950911

Option 2 ID : 4410096950912

Option 3 ID : 4410096950913

Option 4 ID : 4410096950914

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
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Q.35 A shopkeeper purchased 22 dozens of articles at the rate of ₹300 per dozen. He
sold each one of them at the rate of ₹39. What percentage profit did he make?3602

Ans 1. 55%

2. 58%

3. 53%

4. 56%

Question Type : MCQ

Question ID : 441009567176

Option 1 ID : 4410092223826

Option 2 ID : 4410092223825

Option 3 ID : 4410092223827

Option 4 ID : 4410092223824

Status : Answered

Chosen Option : 4

Q.36 The cost of 5 pens and 6 notebooks is ₹92. The cost of 5 notebooks exceeds the
cost of 3 pens by ₹48. What is the cost of 4 pens and 8 notebooks?27

Ans 1. ₹112

2. ₹113

3. ₹115

4. ₹109

Question Type : MCQ

Question ID : 4410091123921

Option 1 ID : 4410094431245

Option 2 ID : 4410094431247

Option 3 ID : 4410094431246

Option 4 ID : 4410094431248

Status : Not Answered

Chosen Option : --

https://applink.adda247.com/d/uHd24maK7j
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Q.37 Given that 610.41 = x, 610.15= y and xz = y3 , then the value of z is close to:3068

Ans 1. 0.87

2. 1.79

3. 2.81

4. 1.1

Question Type : MCQ

Question ID : 441009536593

Option 1 ID : 4410092101769

Option 2 ID : 4410092101771

Option 3 ID : 4410092101770

Option 4 ID : 4410092101768

Status : Not Answered

Chosen Option : --

Q.38 Convert the following expression into a vulgar fraction:

Ans
1. 

2. 

3. 

4. 

Question Type : MCQ

Question ID : 441009358080

Option 1 ID : 4410091398298

Option 2 ID : 4410091398299

Option 3 ID : 4410091398301

Option 4 ID : 4410091398300

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.39

Ans 1. 4

2. 1

3. 16

4. 8

Question Type : MCQ

Question ID : 4410097390

Option 1 ID : 44100929302

Option 2 ID : 44100929303

Option 3 ID : 44100929301

Option 4 ID : 44100929300

Status : Answered

Chosen Option : 1

Q.40

Ans 1. 1234.2

2. 1324.2

3. 1324.1

4. 1234.1

Question Type : MCQ

Question ID : 4410091762537

Option 1 ID : 4410096950150

Option 2 ID : 4410096950152

Option 3 ID : 4410096950151

Option 4 ID : 4410096950149

Status : Answered

Chosen Option : 1

Section : General Studies
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Q.41 Who was elected President of the United Nations General Assembly in June 2025?

Ans 1. Annalena Baerbock

2. António Guterres

3. María Fernanda Espinosa

4. Volker Türk

Question Type : MCQ

Question ID : 4410091327482

Option 1 ID : 4410095241460

Option 2 ID : 4410095241458

Option 3 ID : 4410095241459

Option 4 ID : 4410095241457

Status : Answered

Chosen Option : 2

Q.42 Which ancient text is considered a major landmark in the history of Indian music and
contains chapters on music, drama and dance?

Ans 1. Brihaddesi

2. Natya Shastra

3. Rig Veda

4. Sangeeta Ratnakara

Question Type : MCQ

Question ID : 44100929008

Option 1 ID : 441009115513

Option 2 ID : 441009115512

Option 3 ID : 441009115511

Option 4 ID : 441009115510

Status : Answered

Chosen Option : 2

Q.43 The slogan “Do or Die” was given during which movement?

Ans 1. Non-Cooperation Movement

2. Khilafat Movement

3. Civil Disobedience Movement

4. Quit India Movement

Question Type : MCQ

Question ID : 4410091044947

Option 1 ID : 4410094128886

Option 2 ID : 4410094128889

Option 3 ID : 4410094128887

Option 4 ID : 4410094128888

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
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Q.44 Which of the following is the power of the Supreme Court to examine the
constitutionality of legislative enactments and executive orders of the government.

Ans 1. Judicial Legislation

2. Judicial Review

3. Separation of Powers

4. Special Leave Jurisdiction

Question Type : MCQ

Question ID : 441009243666

Option 1 ID : 441009951981

Option 2 ID : 441009951982

Option 3 ID : 441009951983

Option 4 ID : 441009951984

Status : Answered

Chosen Option : 2

Q.45 What is the tenure of the State Legislative Assembly (Vidhan Sabha)?

Ans 1. Permanent

2. 6 years

3. 4 years

4. 5 years

Question Type : MCQ

Question ID : 44100968774

Option 1 ID : 441009273730

Option 2 ID : 441009273729

Option 3 ID : 441009273727

Option 4 ID : 441009273728

Status : Answered

Chosen Option : 4

Q.46 In which courts did Kathak develop into its two prominent traditions or gharanas?

Ans 1. Jaipur and Lucknow

2. Delhi and Agra

3. Varanasi and Allahabad

4. Jalandhar and Amritsar

Question Type : MCQ

Question ID : 44100973467

Option 1 ID : 441009292180

Option 2 ID : 441009292181

Option 3 ID : 441009292179

Option 4 ID : 441009292178

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.47 At which place did the British army siege and defeat the rebels in September 1857?

Ans 1. Nagpur

2. Delhi

3. Lucknow

4. Meerut

Question Type : MCQ

Question ID : 441009246675

Option 1 ID : 441009961001

Option 2 ID : 441009961000

Option 3 ID : 441009960999

Option 4 ID : 441009960998

Status : Answered

Chosen Option : 4

Q.48 Which of the following reflects social infrastructure in the Indian context?

Ans 1. Export promotion councils and trade zones

2. Corporate marketing hubs in urban cities

3. Schools, hospitals, and health facilities

4. Luxury residential real estate complexes

Question Type : MCQ

Question ID : 4410091779448

Option 1 ID : 4410097017197

Option 2 ID : 4410097017198

Option 3 ID : 4410097017196

Option 4 ID : 4410097017199

Status : Answered

Chosen Option : 1

Q.49 Which of the following factors directly contributed to the outbreak of the Faqir and
Sanyasi Rebellions in Bengal after 1757?

Ans 1. Introduction of railway networks to promote colonial trade in Bengal

2. Increase in land revenue demands by the East India Company in Bengal

3. Abolition of intermediary revenue collectors in northern princely states

4. Expansion of ryotwari settlements in the Madras Presidency region

Question Type : MCQ

Question ID : 4410091779290

Option 1 ID : 4410097016556

Option 2 ID : 4410097016557

Option 3 ID : 4410097016559

Option 4 ID : 4410097016558

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.50 Which of the following is a distinguishing feature of the Directive Principles of State
Policy of India?

Ans 1. They are part of Fundamental Rights.

2. They are justiciable and enforceable by the courts.

3. They are non-justiciable and not enforceable by the courts.

4. They cannot be amended by Parliament.

Question Type : MCQ

Question ID : 44100929893

Option 1 ID : 441009119027

Option 2 ID : 441009119025

Option 3 ID : 441009119026

Option 4 ID : 441009119028

Status : Not Answered

Chosen Option : --

Q.51 Which of the following islands lie(s) in the Bay of Bengal?

Ans 1. Kavaratti island

2. Lakshadweep islands

3. Nicobar islands

4. Pitti island

Question Type : MCQ

Question ID : 44100914604

Option 1 ID : 44100958265

Option 2 ID : 44100958266

Option 3 ID : 44100958268

Option 4 ID : 44100958267

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.52 Which article provides for the appellate jurisdiction of the Supreme Court in
constitutional cases?

Ans 1. Article 131

2. Article 133

3. Article 130

4. Article 132

Question Type : MCQ

Question ID : 441009645797

Option 1 ID : 4410092537284

Option 2 ID : 4410092537286

Option 3 ID : 4410092537283

Option 4 ID : 4410092537285

Status : Answered

Chosen Option : 4

Q.53 Which birds are frequently depicted in Kalamkari paintings ?

Ans 1. Peacocks

2. Penguins

3. Swans

4. Eagles

Question Type : MCQ

Question ID : 44100977346

Option 1 ID : 441009307373

Option 2 ID : 441009307374

Option 3 ID : 441009307372

Option 4 ID : 441009307375

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.54 In which year did the Ministry of Environment, Forest and Climate Change (MoEFCC)
launch the National Clean Air Programme (NCAP) to tackle air pollution?

Ans 1. 2021

2. 2020

3. 2018

4. 2019

Question Type : MCQ

Question ID : 441009334351

Option 1 ID : 4410091303353

Option 2 ID : 4410091303352

Option 3 ID : 4410091303350

Option 4 ID : 4410091303351

Status : Not Answered

Chosen Option : --

Q.55 Which of the following institutional mechanisms forms a central part of India’s
agricultural and village credit delivery system?

Ans 1. Foreign investment entities in strategic defence industries

2. Rural Credit Cooperatives and Regional Rural Banks

3. Private equity investment funds operating in global markets

4. Corporate investment institutions and development finance agencies

Question Type : MCQ

Question ID : 4410091779530

Option 1 ID : 4410097017539

Option 2 ID : 4410097017538

Option 3 ID : 4410097017536

Option 4 ID : 4410097017537

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.56 In July 2025, which of the following cities of Odisha secured the 9th position in India
in the Swachh Survekshan 2024–25 rankings?

Ans 1. Cuttack

2. Rourkela

3. Berhampur

4. Bhubaneswar

Question Type : MCQ

Question ID : 4410091526217

Option 1 ID : 4410096027991

Option 2 ID : 4410096027993

Option 3 ID : 4410096027992

Option 4 ID : 4410096027990

Status : Answered

Chosen Option : 3

Q.57 Which city is known as the "Silicon Valley of India" due to its IT and software service
industry?

Ans 1. Pune

2. Hyderabad

3. Noida

4. Bengaluru

Question Type : MCQ

Question ID : 441009241911

Option 1 ID : 441009945358

Option 2 ID : 441009945357

Option 3 ID : 441009945360

Option 4 ID : 441009945359

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.58 In July 2025, who among the following was honoured with the Sansad Ratna
Awards, 2025, for parliamentary performance?

Ans 1. Mahua Moitra

2. Supriya Sule

3. Rajnath Singh

4. Manish Sisodia

Question Type : MCQ

Question ID : 4410091568362

Option 1 ID : 4410096194735

Option 2 ID : 4410096194732

Option 3 ID : 4410096194734

Option 4 ID : 4410096194733

Status : Answered

Chosen Option : 1

Q.59 On 17 January 2025, Russia signed a 20-year strategic partnership treaty with
which country?

Ans 1. Iraq

2. Iran

3. India

4. China

Question Type : MCQ

Question ID : 441009938516

Option 1 ID : 4410093707767

Option 2 ID : 4410093707766

Option 3 ID : 4410093707765

Option 4 ID : 4410093707764

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.60 The Goods and Services Tax (GST) was introduced in India through which
Constitutional Amendment Act?

Ans 1. 97th Amendment Act

2. 100th Amendment Act

3. 101st Amendment Act

4. 99th Amendment Act

Question Type : MCQ

Question ID : 44100931717

Option 1 ID : 441009126356

Option 2 ID : 441009126358

Option 3 ID : 441009126359

Option 4 ID : 441009126357

Status : Answered

Chosen Option : 3

Q.61 Which Constitutional Amendment Act has introduced a new Part IXA in the Indian
Constitution, which deals with Municipalities?

Ans 1. 61st Amendment Act

2. 74th Amendment Act

3. 42nd Amendment Act

4. 52nd Amendment Act

Question Type : MCQ

Question ID : 4410091576183

Option 1 ID : 4410096225525

Option 2 ID : 4410096225523

Option 3 ID : 4410096225522

Option 4 ID : 4410096225524

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.62 Which of the following correctly explains the primary function of the Diwan-i-Arz
under the Delhi Sultanate?

Ans 1. Supervision of land revenue assessment and agrarian settlements

2. Regulation of royal household expenditure and court ceremonies

3. Organisation and inspection of the military establishment

4. Administration of justice through civil and criminal courts

Question Type : MCQ

Question ID : 4410091779356

Option 1 ID : 4410097016821

Option 2 ID : 4410097016822

Option 3 ID : 4410097016820

Option 4 ID : 4410097016823

Status : Not Answered

Chosen Option : --

Q.63 According to the report of the Ministry of Ports, Shipping and Waterways on the
major Indian ports, which port handled the highest cargo volume among India’s
major ports during FY26 (April–July)?

Ans 1. Deendayal Port

2. Chennai Port

3. Paradip Port

4. Mumbai Port

Question Type : MCQ

Question ID : 4410091778128

Option 1 ID : 4410097011733

Option 2 ID : 4410097011732

Option 3 ID : 4410097011730

Option 4 ID : 4410097011731

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.64 Who was Known as Hazar Dinari ?

Ans 1. Malik Kafur

2. Feroz Tugluq

3. Iltutmish

4. Balban

Question Type : MCQ

Question ID : 441009172155

Option 1 ID : 441009681191

Option 2 ID : 441009681193

Option 3 ID : 441009681194

Option 4 ID : 441009681192

Status : Answered

Chosen Option : 1

Q.65 Which one of the following dynasties and the kings are correctly matched?

Ans 1. Pala Dynasty - Pulakesin I

2. Gupta Dynasty - Iltutmish

3. Chola Dynasty - Mahendravarman I

4. Tuluva Dynasty - Krishna Deva Raya

Question Type : MCQ

Question ID : 44100916041

Option 1 ID : 44100964035

Option 2 ID : 44100964036

Option 3 ID : 44100964034

Option 4 ID : 44100964033

Status : Answered

Chosen Option : 4

Q.66 With reference to India’s geographical location in relation to its neighbours, which of
the following statements is correct?

Ans 1. Afghanistan shares a maritime boundary with India in the Arabian Sea

2. Sri Lanka is connected to India by a continuous land boundary and mountains

3. Bangladesh lies to the east of India and shares boundaries with several Indian states.

4. Nepal lies to the south of India and shares a coastline with the Indian Ocean

Question Type : MCQ

Question ID : 4410091778513

Option 1 ID : 4410097013424

Option 2 ID : 4410097013423

Option 3 ID : 4410097013421

Option 4 ID : 4410097013422

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.67 Which of the following organisations is involved in developing the Vikram 3201 and
Kalpana 3201 microprocessors?

Ans 1. BARC

2. DRDO

3. C-DAC

4. ISRO

Question Type : MCQ

Question ID : 4410091054114

Option 1 ID : 4410094165522

Option 2 ID : 4410094165521

Option 3 ID : 4410094165524

Option 4 ID : 4410094165523

Status : Answered

Chosen Option : 3

Q.68 Who among the following was awarded the Vigyan Ratna in the Rashtriya Vigyan
Puraskar for 2025 in the field of Science and Technology?

Ans 1. Prof. Jayant Vishnu Narlikar

2. Dr. C.N.R. Rao

3. Dr. Tessy Thomas

4. Dr. A.P.J. Abdul Kalam

Question Type : MCQ

Question ID : 4410091775085

Option 1 ID : 4410096999787

Option 2 ID : 4410096999789

Option 3 ID : 4410096999790

Option 4 ID : 4410096999788

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.69 Which company received conditional approval to commence satellite-based internet
services in India in May 2025?

Ans 1. Amazon Kuiper

2. OneWeb

3. Blue Origin

4. SpaceX's Starlink

Question Type : MCQ

Question ID : 441009328666

Option 1 ID : 4410091281091

Option 2 ID : 4410091281090

Option 3 ID : 4410091281093

Option 4 ID : 4410091281092

Status : Not Answered

Chosen Option : --

Q.70 Smt. Sulochana Chavan, a recipient of the Padma Shri award, is legendary for her
contribution to which traditional folk music style?

Ans 1. Baul

2. Bihu

3. Lavani

4. Pandavani

Question Type : MCQ

Question ID : 441009607133

Option 1 ID : 4410092383649

Option 2 ID : 4410092383652

Option 3 ID : 4410092383650

Option 4 ID : 4410092383651

Status : Not Answered

Chosen Option : --

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.71 Which of the following years was designated as the Year of Human Resource
Development and Discipline in India?

Ans 1. 2025

2. 2024

3. 2023

4. 2022

Question Type : MCQ

Question ID : 441009247801

Option 1 ID : 441009965206

Option 2 ID : 441009965205

Option 3 ID : 441009965204

Option 4 ID : 441009965203

Status : Answered

Chosen Option : 1

Q.72 Consider the statements:
Statement I: The procedure to amend the Constitution is given in the Constitution
itself.
Statement II: Parliament has the power to add, modify or delete Constitutional
provisions.

Ans 1. Both statements are correct.

2. Statement I is correct, statement II is incorrect.

3. Both statements are incorrect.

4. Statement I is incorrect, statement II is correct.

Question Type : MCQ

Question ID : 441009243352

Option 1 ID : 441009950939

Option 2 ID : 441009950937

Option 3 ID : 441009950940

Option 4 ID : 441009950938

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.73 Which state has produced the highest Bajra during 2023-24?

Ans 1. Chhattisgarh

2. Rajasthan

3. Uttar Pradesh

4. Madhya Pradesh

Question Type : MCQ

Question ID : 441009248684

Option 1 ID : 441009968737

Option 2 ID : 441009968739

Option 3 ID : 441009968740

Option 4 ID : 441009968738

Status : Not Answered

Chosen Option : --

Q.74 Luanda is the capital of which African country?

Ans 1. Namibia

2. Zambia

3. Ghana

4. Angola

Question Type : MCQ

Question ID : 4410091775231

Option 1 ID : 4410097000370

Option 2 ID : 4410097000367

Option 3 ID : 4410097000369

Option 4 ID : 4410097000368

Status : Not Answered

Chosen Option : --

Q.75 The western coastal plains of India are mainly:

Ans 1. submerged coasts

2. emergent coasts

3. depositional plains

4. deltaic plains

Question Type : MCQ

Question ID : 4410091312354

Option 1 ID : 4410095181105

Option 2 ID : 4410095181104

Option 3 ID : 4410095181106

Option 4 ID : 4410095181107

Status : Not Answered

Chosen Option : --

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.76 Which architectural style is primarily associated with the temples of southern India?

Ans 1. Nagara style

2. Vesara style

3. Dravida style

4. Hemadpanti style

Question Type : MCQ

Question ID : 44100992411

Option 1 ID : 441009367358

Option 2 ID : 441009367360

Option 3 ID : 441009367359

Option 4 ID : 441009367361

Status : Answered

Chosen Option : 3

Q.77 Sri Lanka is separated from India by which of the following water bodies?

Ans 1. Bering Strait and Bay of Bengal

2. Palk Strait and Gulf of Mannar

3. Malacca Strait and Andaman Sea

4. Hormuz Strait and Arabian Sea

Question Type : MCQ

Question ID : 4410091778511

Option 1 ID : 4410097013416

Option 2 ID : 4410097013413

Option 3 ID : 4410097013414

Option 4 ID : 4410097013415

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.78 When was the National Food for Work Programme (NFFWP) was launched in India to
generate supplementary wage employment in the 150 most backward districts of
the country?

Ans 1. 2010

2. 2004

3. 2009

4. 2008

Question Type : MCQ

Question ID : 441009868977

Option 1 ID : 4410093428939

Option 2 ID : 4410093428941

Option 3 ID : 4410093428942

Option 4 ID : 4410093428940

Status : Not Answered

Chosen Option : --

Q.79 Which of the following agreements formally suspended the Civil Disobedience
Movement in 1931?

Ans 1. Lucknow Pact

2. Gandhi-Irwin Pact

3. Delhi Pact

4. Poona Pact

Question Type : MCQ

Question ID : 4410091779354

Option 1 ID : 4410097016813

Option 2 ID : 4410097016812

Option 3 ID : 4410097016814

Option 4 ID : 4410097016815

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.80 In February 2026, the Government of India launched which policy initiative to
strengthen national security through a coordinated, intelligence-based response to
terrorism and radical activities?

Ans 1. Defence Manufacturing and Export Promotion Strategy

2. Border Infrastructure and Civil-Military Cooperation Plan

3. Indo-Pacific Maritime Strategic Partnership Framework

4. National Policy for Counter-Terror Intelligence Coordination

Question Type : MCQ

Question ID : 4410091774776

Option 1 ID : 4410096998615

Option 2 ID : 4410096998616

Option 3 ID : 4410096998614

Option 4 ID : 4410096998613

Status : Not Answered

Chosen Option : --

Q.81 Choose the synonym of the highlighted word that best fits the blank.
The historian described the treaty as fragile, warning that the ________ agreement
might collapse at the slightest dispute.

Ans 1. robust

2. binding

3. lasting

4. delicate

Question Type : MCQ

Question ID : 4410091721477

Option 1 ID : 4410096789131

Option 2 ID : 4410096789133

Option 3 ID : 4410096789130

Option 4 ID : 4410096789132

Status : Answered

Chosen Option : 4

Section : English

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.82 Choose the correct active form of the following passive sentence.
The annual budget proposal is thoroughly reviewed by the finance team before it is
presented to the board.

Ans 1. The finance team thoroughly reviewing the annual budget proposal before they present it to
the board.

2. The finance team thoroughly reviewed the annual budget proposal before they present it to
the board.

3. The finance team thoroughly review the annual budget proposal before they present it to
the board.

4. The finance team thoroughly reviews the annual budget proposal before they present it to
the board.

Question Type : MCQ

Question ID : 4410091721458

Option 1 ID : 4410096789056

Option 2 ID : 4410096789057

Option 3 ID : 4410096789055

Option 4 ID : 4410096789054

Status : Answered

Chosen Option : 4

Q.83 Identify the error in the following sentence and choose the corrected version of it
from the options given.
The CEO will announces the new policy in tomorrow’s meeting.

Ans 1. The CEO would announces the new policy in tomorrow’s meeting.

2. The CEO announce the new policy in tomorrow’s meeting.

3. The CEO will be announce the new policy in tomorrow’s meeting.

4. The CEO will announce the new policy in tomorrow’s meeting.

Question Type : MCQ

Question ID : 441009383320

Option 1 ID : 4410091498828

Option 2 ID : 4410091498830

Option 3 ID : 4410091498831

Option 4 ID : 4410091498829

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.84 What is the one-word substitution for the following expression?
A person who avoids human company, distrusts others, and has a general dislike
for humankind.

Ans 1. extrovert

2. misanthrope

3. egoist

4. philanthropist

Question Type : MCQ

Question ID : 4410091601717

Option 1 ID : 4410096326470

Option 2 ID : 4410096326472

Option 3 ID : 4410096326473

Option 4 ID : 4410096326471

Status : Answered

Chosen Option : 2

Q.85 Identify the part of the sentence that contains an error.
"He was played cricket when it started to rain."

Ans 1. was played

2. He

3. when it started to rain

4. cricket

Question Type : MCQ

Question ID : 441009866114

Option 1 ID : 4410093417577

Option 2 ID : 4410093417576

Option 3 ID : 4410093417579

Option 4 ID : 4410093417578

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.86 Select the proverb that can substitute the underlined segment in the given sentence.
The prime requisite of parenthood in today’s scenario is to make their children
understand that small savings make one rich together.

Ans 1. make hay while the sunshines

2. where there is a will there is a way

3. better late than never

4. many a drop make an ocean

Question Type : MCQ

Question ID : 441009917782

Option 1 ID : 4410093625186

Option 2 ID : 4410093625185

Option 3 ID : 4410093625187

Option 4 ID : 4410093625188

Status : Answered

Chosen Option : 4

Q.87 The given sentence has an error. Select the option that rectifies the sentence.
The new software is incredibly efficient; sometimes, it is very easy for new
employees to learn.

Ans 1. The new software is incredibly efficient; however, it is very easy for new employees to learn.

2. The new software is incredibly efficient; always, it is very easy for new employees to learn.

3. The new software is incredibly efficient; moreover, it is very easy for new employees to
learn.

4. The new software is incredibly efficient; rarely, it is very easy for new employees to learn.

Question Type : MCQ

Question ID : 441009378696

Option 1 ID : 4410091480442

Option 2 ID : 4410091480443

Option 3 ID : 4410091480441

Option 4 ID : 4410091480444

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.88 Select the correct spelling of the incorrectly spelt word in the given sentence.

The study found that the prevalence of polypharmacy was 33.7% with significant
associations to multiple commorbidities, recent transition of care and recent
hospitalisation.

Ans 1. comorbidities

2. transtion

3. prevalance

4. polypharmecy

Question Type : MCQ

Question ID : 44100921864

Option 1 ID : 44100987181

Option 2 ID : 44100987182

Option 3 ID : 44100987179

Option 4 ID : 44100987180

Status : Answered

Chosen Option : 4

Q.89 Select the most appropriate one-word substitute for the underlined words.
Even after many failures, she showed great determination and did not give up.

Ans 1. weakness

2. carelessness

3. laziness

4. tenacity

Question Type : MCQ

Question ID : 4410091721497

Option 1 ID : 4410096789210

Option 2 ID : 4410096789213

Option 3 ID : 4410096789211

Option 4 ID : 4410096789212

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.90 Choose the antonym of the highlighted word in the following sentence.
After hearing the sad news, he became morose.

Ans 1. solemn

2. thoughtful

3. joyful

4. quiet

Question Type : MCQ

Question ID : 4410091734620

Option 1 ID : 4410096840572

Option 2 ID : 4410096840574

Option 3 ID : 4410096840571

Option 4 ID : 4410096840573

Status : Answered

Chosen Option : 3

Q.91 Select the correct indirect narration of the given sentence.
The Finance Minister said, “The new budget will focus on job creation.”

Ans 1. The Finance Minister announced that the new budget would focus on job creation.

2. The Finance Minister announced that the new budget focus on job creation.

3. The Finance Minister announced that the new budget will be focused on job creation.

4. The Finance Minister announced that the new budget focused on job creation.

Question Type : MCQ

Question ID : 4410091388531

Option 1 ID : 4410095484562

Option 2 ID : 4410095484563

Option 3 ID : 4410095484564

Option 4 ID : 4410095484561

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.92 Select the INCORRECTLY spelt word.

Ans 1. Dilettante

2. Philanthropy

3. Quinessential

4. Camouflage

Question Type : MCQ

Question ID : 44100910778

Option 1 ID : 44100942895

Option 2 ID : 44100942897

Option 3 ID : 44100942896

Option 4 ID : 44100942894

Status : Marked For Review

Chosen Option : 4

Q.93 "You can’t have your cake and eat it too." What does this proverb imply?

Ans 1. You can enjoy everything without consequences.

2. You must choose between two mutually exclusive things.

3. Eating cake is not allowed before dinner.

4. You should always share what you have with others.

Question Type : MCQ

Question ID : 441009889640

Option 1 ID : 4410093512507

Option 2 ID : 4410093512508

Option 3 ID : 4410093512509

Option 4 ID : 4410093512506

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.94 Parts of a sentence are given below. The first part is in the correct order, while the
other parts of the sentence are jumbled up. Arrange the parts in the correct order to
form a meaningful and coherent sentence.

We placed/ on the corner(Q)/ the laptop(P)/ in the room(S)/ of the desk(R).

Ans 1. RSPQ

2. QSPR

3. PQRS

4. PSQR

Question Type : MCQ

Question ID : 4410091224538

Option 1 ID : 4410094831627

Option 2 ID : 4410094831629

Option 3 ID : 4410094831630

Option 4 ID : 4410094831628

Status : Answered

Chosen Option : 3

Q.95 The given sentence contains an error. Select the option that rectifies the sentence.
Ms. Preethi commented, “The team played well, unless the umpiring was poor, so
they lost.”

Ans 1. Ms. Preethi commented, “The team played well, so the umpiring was poor, yet they lost.”

2. Ms. Preethi commented, “The team played well, unless the umpiring was poor, for they
lost.”

3. Ms. Preethi commented, “The team played well, because the umpiring was poor, so they
lost.”

4. Ms. Preethi commented, “The team played well, but the umpiring was poor, so they lost.”

Question Type : MCQ

Question ID : 441009378701

Option 1 ID : 4410091480464

Option 2 ID : 4410091480462

Option 3 ID : 4410091480463

Option 4 ID : 4410091480461

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.96 Select the INCORRECTLY spelt word.

Ans 1. Famous

2. Beautiful

3. Occassion

4. Library

Question Type : MCQ

Question ID : 44100911231

Option 1 ID : 44100944758

Option 2 ID : 44100944755

Option 3 ID : 44100944756

Option 4 ID : 44100944757

Status : Answered

Chosen Option : 3

Q.97 Identify the error in the given sentence and choose the option that corrects it.

He run every morning before school.

Ans 1. He ranned every morning before school.

2. He runned every morning before school.

3. He has ranned every morning before school.

4. He runs every morning before school.

Question Type : MCQ

Question ID : 4410091419478

Option 1 ID : 4410095606833

Option 2 ID : 4410095606830

Option 3 ID : 4410095606832

Option 4 ID : 4410095606831

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.98 Choose the correct meaning for the idiom given below in bold.

Consistency in studying the syllabus and a deep understanding of current affairs
hold the key to clearing the UPSC exam.

Ans 1. to face a difficult situation bravely

2. to remain positive in a difficult situation

3. to do something quickly or take shortcuts

4. to have the essential knowledge and to have control of something

Question Type : MCQ

Question ID : 4410091283157

Option 1 ID : 4410095064305

Option 2 ID : 4410095064304

Option 3 ID : 4410095064303

Option 4 ID : 4410095064302

Status : Answered

Chosen Option : 4

Q.99 Select the option that expresses the given sentence in reported speech.
“Are you coming to the party?” he asked me.

Ans 1. He asked me if I was coming to the party.

2. He asked me if am I coming to the party.

3. He asked me that I was coming to the party.

4. He asked me whether I am coming to the party.

Question Type : MCQ

Question ID : 4410091133003

Option 1 ID : 4410094467379

Option 2 ID : 4410094467382

Option 3 ID : 4410094467381

Option 4 ID : 4410094467380

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
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Q.100 Choose the most appropriate form of future tense from the given options to
complete the sentence.

I ________ a T.V. show tomorrow.

Ans 1. have watched

2. will watch

3. have watch

4. watch

Question Type : MCQ

Question ID : 4410091190037

Option 1 ID : 4410094694297

Option 2 ID : 4410094694296

Option 3 ID : 4410094694298

Option 4 ID : 4410094694295

Status : Answered

Chosen Option : 2

Q.101 Select the antonym of the highlighted word as used in the sentence below.
The author’s depiction of the protagonist was remarkably "candid", refusing to mask
any flaws.

Ans 1. deceitful

2. quiet

3. open

4. honest

Question Type : MCQ

Question ID : 4410091721486

Option 1 ID : 4410096789168

Option 2 ID : 4410096789167

Option 3 ID : 4410096789169

Option 4 ID : 4410096789166

Status : Not Answered

Chosen Option : --

https://applink.adda247.com/d/uHd24maK7j
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Q.102 Select the grammatically correct sentence from the following options.

Ans 1. She never seen snowfall before this trip.

2. She had never seen snowfall before this trip.

3. She had never see snowfall before this trip.

4. She had never saw snowfall before this trip.

Question Type : MCQ

Question ID : 4410091132914

Option 1 ID : 4410094467029

Option 2 ID : 4410094467028

Option 3 ID : 4410094467030

Option 4 ID : 4410094467027

Status : Answered

Chosen Option : 2

Q.103 Select the correct passive voice version of the given sentence.

The court advised the culprit to pay a hefty amount as compensation for the heinous
crime he committed.

Ans 1. The culprit had been advised by the court to pay a hefty amount as compensation for the
heinous crime he committed.

2. The culprit has been advised by the court to pay a heft amount as compensation for the
heinous crime he committed.

3. The culprit was advised by the court to be paid a hefty amount as compensation for the
heinous crime he committed.

4. The culprit was advised by the court to pay a hefty amount as compensation for the
heinous crime he had committed.

Question Type : MCQ

Question ID : 4410091210975

Option 1 ID : 4410094777396

Option 2 ID : 4410094777397

Option 3 ID : 4410094777395

Option 4 ID : 4410094777394

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.104 Parts of a sentence are given below in jumbled order. Arrange the parts in the
correct order to form a meaningful sentence.

A. supplement their weaker areas with
B. not only bring their own strengths, but also
C. learning settings, individuals
D. effective strategies learnt from others
E. in collaborative

Ans 1. B - A - D - E - C

2. A - B - D - C - E

3. E - C - B - A - D

4. C - E - A - D - B

Question Type : MCQ

Question ID : 441009126791

Option 1 ID : 441009503841

Option 2 ID : 441009503842

Option 3 ID : 441009503843

Option 4 ID : 441009503840

Status : Answered

Chosen Option : 3

Q.105 Convert the following sentence from Indirect to Direct Speech.
The teacher asked the student if he had revised his lessons.

Ans 1. The teacher said, "Did you revised your lessons?"

2. The teacher asked, "Had you revise your lessons?"

3. The teacher asked, "Have you revised your lessons?"

4. The teacher asked, "Do you revise your lessons?"

Question Type : MCQ

Question ID : 4410091169830

Option 1 ID : 4410094613716

Option 2 ID : 4410094613719

Option 3 ID : 4410094613718

Option 4 ID : 4410094613717

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.106 Select the word that expresses the opposite meaning of the highlighted term and
logically completes the sentence.
The teacher asked students to keep their answers short, but Ravi wrote a very
________ response with many unnecessary details.

Ans 1. brief

2. clear

3. long

4. neat

Question Type : MCQ

Question ID : 4410091721481

Option 1 ID : 4410096789146

Option 2 ID : 4410096789148

Option 3 ID : 4410096789147

Option 4 ID : 4410096789149

Status : Answered

Chosen Option : 3

Q.107 Identify the part that has an error in the given sentence.
Danny is taller / than Sue / or shorter / than Porto.

Ans 1. than Sue

2. than Porto.

3. Danny is taller

4. or shorter

Question Type : MCQ

Question ID : 44100948146

Option 1 ID : 441009191722

Option 2 ID : 441009191724

Option 3 ID : 441009191721

Option 4 ID : 441009191723

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.108 Choose the grammatically correct sentence.

Ans 1. Each worker has been instructed the emergency procedures during the initial training
period.

2. The manager explained to the staff the procedures, but some confusion about the protocol
remained.

3. All new employees is given the orientation booklet before starting work at the company.

4. The supervisor will give the trainees detailed instructions once the safety briefing has
finished.

Question Type : MCQ

Question ID : 4410091721468

Option 1 ID : 4410096789097

Option 2 ID : 4410096789095

Option 3 ID : 4410096789094

Option 4 ID : 4410096789096

Status : Answered

Chosen Option : 1

Q.109 Select the most appropriate option to substitute the underlined segment in the given
sentence.
After months of unemployment, Shekhar had to swallow his pride and ask his
parents for help.

Ans 1. raise his spirits

2. humble himself

3. inflate his ego

4. wash his hands

Question Type : MCQ

Question ID : 441009900998

Option 1 ID : 4410093558064

Option 2 ID : 4410093558063

Option 3 ID : 4410093558062

Option 4 ID : 4410093558065

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.110 Choose the best one-word substitution for the underlined segment.

He was unwilling to forgive even the smallest mistake, which made him difficult to
work with.

Ans 1. Cheerful

2. Careful

3. Merciless

4. Forgiving

Question Type : MCQ

Question ID : 4410091721495

Option 1 ID : 4410096789204

Option 2 ID : 4410096789205

Option 3 ID : 4410096789203

Option 4 ID : 4410096789202

Status : Answered

Chosen Option : 2

Comprehension:

Read the passage carefully and answer the questions that follow.

The invention of the printing press by Johannes Gutenberg in the mid-15th century marked a turning
point in human history. Before its creation, books were copied by hand, often taking months or even
years to produce a single manuscript. As a result, knowledge remained confined to wealthy elites
and religious institutions. Gutenberg’s press revolutionized this system by enabling the mass
production of books, drastically reducing costs and increasing availability. Ordinary people gained
access to ideas, literature, and scientific works that were once out of reach. This democratization of
knowledge fueled movements such as the Renaissance and the Reformation, which reshaped
European society. The printing press not only changed how information spread but also empowered
individuals to think critically and independently. It laid the foundation for modern education and
continues to symbolize the power of accessible knowledge in shaping civilizations.

SubQuestion No : 111

Q.111 Who invented the printing press?

Ans 1. Galileo Galilei

2. Martin Luther

3. Johannes Gutenberg

4. Isaac Newton

Question Type : MCQ

Question ID : 4410091341642

Option 1 ID : 4410095298668

Option 2 ID : 4410095298666

Option 3 ID : 4410095298667

Option 4 ID : 4410095298669

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Comprehension:

Read the passage carefully and answer the questions that follow.

The invention of the printing press by Johannes Gutenberg in the mid-15th century marked a turning
point in human history. Before its creation, books were copied by hand, often taking months or even
years to produce a single manuscript. As a result, knowledge remained confined to wealthy elites
and religious institutions. Gutenberg’s press revolutionized this system by enabling the mass
production of books, drastically reducing costs and increasing availability. Ordinary people gained
access to ideas, literature, and scientific works that were once out of reach. This democratization of
knowledge fueled movements such as the Renaissance and the Reformation, which reshaped
European society. The printing press not only changed how information spread but also empowered
individuals to think critically and independently. It laid the foundation for modern education and
continues to symbolize the power of accessible knowledge in shaping civilizations.

SubQuestion No : 112

Q.112 What was one major problem with books before the printing press?

Ans 1. They were too large to carry

2. They were banned by rulers

3. They took a long time to copy by hand

4. They were written in Latin only

Question Type : MCQ

Question ID : 4410091341643

Option 1 ID : 4410095298671

Option 2 ID : 4410095298673

Option 3 ID : 4410095298672

Option 4 ID : 4410095298670

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Comprehension:

Read the passage carefully and answer the questions that follow.

The invention of the printing press by Johannes Gutenberg in the mid-15th century marked a turning
point in human history. Before its creation, books were copied by hand, often taking months or even
years to produce a single manuscript. As a result, knowledge remained confined to wealthy elites
and religious institutions. Gutenberg’s press revolutionized this system by enabling the mass
production of books, drastically reducing costs and increasing availability. Ordinary people gained
access to ideas, literature, and scientific works that were once out of reach. This democratization of
knowledge fueled movements such as the Renaissance and the Reformation, which reshaped
European society. The printing press not only changed how information spread but also empowered
individuals to think critically and independently. It laid the foundation for modern education and
continues to symbolize the power of accessible knowledge in shaping civilizations.

SubQuestion No : 113

Q.113 How did the printing press empower ordinary people?

Ans 1. By providing cheaper access to books and knowledge

2. By giving them jobs in monasteries

3. By teaching them to read instantly

4. By limiting religious influence

Question Type : MCQ

Question ID : 4410091341644

Option 1 ID : 4410095298675

Option 2 ID : 4410095298676

Option 3 ID : 4410095298674

Option 4 ID : 4410095298677

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
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Comprehension:

Read the passage carefully and answer the questions that follow.

The invention of the printing press by Johannes Gutenberg in the mid-15th century marked a turning
point in human history. Before its creation, books were copied by hand, often taking months or even
years to produce a single manuscript. As a result, knowledge remained confined to wealthy elites
and religious institutions. Gutenberg’s press revolutionized this system by enabling the mass
production of books, drastically reducing costs and increasing availability. Ordinary people gained
access to ideas, literature, and scientific works that were once out of reach. This democratization of
knowledge fueled movements such as the Renaissance and the Reformation, which reshaped
European society. The printing press not only changed how information spread but also empowered
individuals to think critically and independently. It laid the foundation for modern education and
continues to symbolize the power of accessible knowledge in shaping civilizations.

SubQuestion No : 114

Q.114 What is the central theme of the passage?

Ans 1. The difficulties of medieval book production

2. The rise of scientific inventions

3. The impact of technology on knowledge and society

4. The role of religion in Europe

Question Type : MCQ

Question ID : 4410091341645

Option 1 ID : 4410095298680

Option 2 ID : 4410095298681

Option 3 ID : 4410095298679

Option 4 ID : 4410095298678

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Comprehension:

Read the passage carefully and answer the questions that follow.

The invention of the printing press by Johannes Gutenberg in the mid-15th century marked a turning
point in human history. Before its creation, books were copied by hand, often taking months or even
years to produce a single manuscript. As a result, knowledge remained confined to wealthy elites
and religious institutions. Gutenberg’s press revolutionized this system by enabling the mass
production of books, drastically reducing costs and increasing availability. Ordinary people gained
access to ideas, literature, and scientific works that were once out of reach. This democratization of
knowledge fueled movements such as the Renaissance and the Reformation, which reshaped
European society. The printing press not only changed how information spread but also empowered
individuals to think critically and independently. It laid the foundation for modern education and
continues to symbolize the power of accessible knowledge in shaping civilizations.

SubQuestion No : 115

Q.115 What is the most appropriate title for this passage?

Ans 1. “The Fall of Manuscripts”

2. “The Renaissance and Reformation”

3. “The Life of Gutenberg”

4. “The Revolution of Knowledge”

Question Type : MCQ

Question ID : 4410091341646

Option 1 ID : 4410095298684

Option 2 ID : 4410095298685

Option 3 ID : 4410095298682

Option 4 ID : 4410095298683

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Comprehension:

In the following passage, some words have been deleted. Fill in the blanks with the help of the
alternatives given. Select the most appropriate option for each number.

The Red Fort in Delhi is a famous historical landmark built by Emperor Shah Jahan using red
sandstone, giving it a distinctive (1) ______. Once the (2) ______ residence of Mughal rulers, it houses
structures like the Diwan-i-Aam and Diwan-i-Khas. The fort holds deep (3) ______ significance, is
a/an (4) ______ heritage site, and reflects India’s rich (5) ______ legacy.

SubQuestion No : 116

Q.116 Select the most appropriate option to fill in blank (1).

Ans 1. height

2. strength

3. colour

4. decoration

Question Type : MCQ

Question ID : 4410091584238

Option 1 ID : 4410096258254

Option 2 ID : 4410096258253

Option 3 ID : 4410096258252

Option 4 ID : 4410096258251

Status : Answered

Chosen Option : 3

Comprehension:

In the following passage, some words have been deleted. Fill in the blanks with the help of the
alternatives given. Select the most appropriate option for each number.

The Red Fort in Delhi is a famous historical landmark built by Emperor Shah Jahan using red
sandstone, giving it a distinctive (1) ______. Once the (2) ______ residence of Mughal rulers, it houses
structures like the Diwan-i-Aam and Diwan-i-Khas. The fort holds deep (3) ______ significance, is
a/an (4) ______ heritage site, and reflects India’s rich (5) ______ legacy.

SubQuestion No : 117

Q.117 Select the most appropriate option to fill in blank (2).

Ans 1. temporary

2. ordinary

3. public

4. royal

Question Type : MCQ

Question ID : 4410091584239

Option 1 ID : 4410096258255

Option 2 ID : 4410096258256

Option 3 ID : 4410096258258

Option 4 ID : 4410096258257

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Comprehension:

In the following passage, some words have been deleted. Fill in the blanks with the help of the
alternatives given. Select the most appropriate option for each number.

The Red Fort in Delhi is a famous historical landmark built by Emperor Shah Jahan using red
sandstone, giving it a distinctive (1) ______. Once the (2) ______ residence of Mughal rulers, it houses
structures like the Diwan-i-Aam and Diwan-i-Khas. The fort holds deep (3) ______ significance, is
a/an (4) ______ heritage site, and reflects India’s rich (5) ______ legacy.

SubQuestion No : 118

Q.118 Select the most appropriate option to fill in blank (3).

Ans 1. natural

2. scientific

3. cultural

4. financial

Question Type : MCQ

Question ID : 4410091584240

Option 1 ID : 4410096258262

Option 2 ID : 4410096258261

Option 3 ID : 4410096258259

Option 4 ID : 4410096258260

Status : Answered

Chosen Option : 3

Comprehension:

In the following passage, some words have been deleted. Fill in the blanks with the help of the
alternatives given. Select the most appropriate option for each number.

The Red Fort in Delhi is a famous historical landmark built by Emperor Shah Jahan using red
sandstone, giving it a distinctive (1) ______. Once the (2) ______ residence of Mughal rulers, it houses
structures like the Diwan-i-Aam and Diwan-i-Khas. The fort holds deep (3) ______ significance, is
a/an (4) ______ heritage site, and reflects India’s rich (5) ______ legacy.

SubQuestion No : 119

Q.119 Select the most appropriate option to fill in blank (4).

Ans 1. insignificant

2. ancient

3. sensitive

4. remote

Question Type : MCQ

Question ID : 4410091584241

Option 1 ID : 4410096258266

Option 2 ID : 4410096258264

Option 3 ID : 4410096258263

Option 4 ID : 4410096258265

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Comprehension:

In the following passage, some words have been deleted. Fill in the blanks with the help of the
alternatives given. Select the most appropriate option for each number.

The Red Fort in Delhi is a famous historical landmark built by Emperor Shah Jahan using red
sandstone, giving it a distinctive (1) ______. Once the (2) ______ residence of Mughal rulers, it houses
structures like the Diwan-i-Aam and Diwan-i-Khas. The fort holds deep (3) ______ significance, is
a/an (4) ______ heritage site, and reflects India’s rich (5) ______ legacy.

SubQuestion No : 120

Q.120 Select the most appropriate option to fill in blank (5).

Ans 1. rural

2. moral

3. geographical

4. historic

Question Type : MCQ

Question ID : 4410091584242

Option 1 ID : 4410096258268

Option 2 ID : 4410096258270

Option 3 ID : 4410096258269

Option 4 ID : 4410096258267

Status : Answered

Chosen Option : 4

Q.121 ଉପଯୁକ୍ତ  ଅବ୍ୟୟ ବାଛି ଶୂନ୍ୟସ୍ଥାନ ପୂରଣ କରନ୍ତୁ :

ତା’ ପାଖରେ ______ ଗୋପାଳ ଆଉ ନାହିଁ ଯେ ଠୁକଠାକ ଖର୍ଚ୍ଚ କରିଦେବ ।

Ans 1. ଯେହେତୁ

2. ଯଦିଓ

3. ଠନଠନ

4. ଏବଂ

Question Type : MCQ

Question ID : 4410091675461

Option 1 ID : 4410096610960

Option 2 ID : 4410096610961

Option 3 ID : 4410096610963

Option 4 ID : 4410096610962

Status : Answered

Chosen Option : 3

Section : Odia
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Q.122 ଅବ୍ୟୟ ପଦ ବ୍ୟବହାର କରି ବାକ୍ୟଟିକୁ  ସମ୍ପୂର୍ଣ୍ଣ କର ।

''ଦେଶ ସ୍ୱାଧୀନ ହୋଇଛି , ____ ଲୋକଙ୍କ ଦୁଃ ଖ ଦୂର ହୋଇନି ।''

Ans 1. କିନ୍ତୁ

2. କେବେ

3. ପୁଣି

4. ଏବଂ

Question Type : MCQ

Question ID : 4410091483708

Option 1 ID : 4410095861712

Option 2 ID : 4410095861711

Option 3 ID : 4410095861709

Option 4 ID : 4410095861710

Status : Answered

Chosen Option : 1

Q.123 ନିମ୍ନଲିଖି ତ ବାକ୍ୟର ଠିକ୍ ଇଂରାଜୀ ଅନୁବାଦ ବାଛ-

"ସତ୍ୟ ଓ ଅହିଂସା ତାଙ୍କ ଜୀବନର ଆଦର୍ଶ ଥି ଲା " ।

Ans 1. Truth and non-violence are the ideals of his life.

2. Truth and non-violence were the ideals of his life.

3. Truth and non-violence are his ideals of life.

4. Truth and non-violence were his ideals.

Question Type : MCQ

Question ID : 4410091725619

Option 1 ID : 4410096805535

Option 2 ID : 4410096805537

Option 3 ID : 4410096805538

Option 4 ID : 4410096805536

Status : Answered

Chosen Option : 2
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Q.124 "ଆଖି ରେ ଧୂଳି ଦେବା"ର ଅର୍ଥ କ'ଣ?

Ans 1. ଠକିବା

2. ଆଶ୍ଚର୍ଯ୍ୟ

3. ସୁଖ

4. ଭୟ

Question Type : MCQ

Question ID : 4410091488144

Option 1 ID : 4410095878720

Option 2 ID : 4410095878721

Option 3 ID : 4410095878723

Option 4 ID : 4410095878722

Status : Answered

Chosen Option : 1

Q.125 ପ୍ରଦତ୍ତ ବାକ୍ୟରେ ରେଖାଙ୍କିତ ହୋଇଥି ବା ଶବ୍ଦ ସ୍ଥାନରେ ଏକ ଉପଯୁକ୍ତ  ବାକ୍ୟ ଖଣ୍ଡ ବ୍ୟବହାର କରନ୍ତୁ ।

ଆମେ ପ୍ରତିଦିନ ସକାଳୁ  ବ୍ୟାୟାମ ଲାଗି ଜିମ ଯିବି।

Ans 1. ବ୍ୟାୟାମ ଲାଗି ଜିମ ଯାଏ

2. ବ୍ୟାୟାମ ଲାଗି ଜିମ ଗଲା

3. ବ୍ୟାୟାମ ଲାଗି ଜିମ ଯାଉ

4. ପରିବର୍ତ୍ତନର ଆବଶ୍ୟକତା ନାହିଁ।

Question Type : MCQ

Question ID : 4410091235683

Option 1 ID : 4410094876421

Option 2 ID : 4410094876420

Option 3 ID : 4410094876422

Option 4 ID : 4410094876423

Status : Answered

Chosen Option : 3
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Q.126 ନିମ୍ନଲିଖି ତ ପ୍ରଶ୍ନରେ ଦିଆଯାଇଥି ବା ଚାରୋଟି ବିକଳ୍ପ  ମଧ୍ୟରୁ  ସେହି ବିକଳ୍ପକୁ  ବାଛନ୍ତୁ , ଯାହା ପ୍ରଦତ୍ତ ପ୍ରବାଦ ବା
ଲୋକବାଣୀର ଅର୍ଥକୁ
ସର୍ବୋତ୍ତମ ଭାବରେ ପ୍ରକାଶ କରେ।
ବକର ବେକ ବଢ଼ିଲେ ମୀନର ବିପତ୍ତି

Ans 1. ବକର ବେକ ବଢ଼ିବା

2. ଶତ୍ରୁର ସୁବିଧା ବିପଦର କାରଣ

3. ଶତ୍ରୁକୁ  ସୁବିଧା ଦେବା

4. ବକ ମୀନ ମାରିବା

Question Type : MCQ

Question ID : 4410091238014

Option 1 ID : 4410094885587

Option 2 ID : 4410094885584

Option 3 ID : 4410094885586

Option 4 ID : 4410094885585

Status : Answered

Chosen Option : 2

Q.127 ନିମ୍ନଲିଖି ତ ଶବ୍ଦଗୁଡ଼ିକର ସମାନାର୍ଥବୋଧକ ଶବ୍ଦ ଲେଖ।
ନୀତିମାନ ଲୋକ ସବୁ ବେଳେ "ନୀତି" ଅନୁସରଣ କରନ୍ତି।

Ans 1. ଅଜ୍ଞାନ

2. ଚତୁରତା

3. ଅନୀତି

4. ଧର୍ମ

Question Type : MCQ

Question ID : 4410091485499

Option 1 ID : 4410095868460

Option 2 ID : 4410095868459

Option 3 ID : 4410095868457

Option 4 ID : 4410095868458

Status : Answered

Chosen Option : 4
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Q.128 “ଗୋସାଇଁ” ର ତତ୍ସମ ଶବ୍ଦ କେଉଁଟି ଅଟେ?

Ans 1. ପୁରୋହିତ

2. ପୁରାଣ

3. ଚାକର

4. ଗୋସ୍ଵାମୀ

Question Type : MCQ

Question ID : 4410091235915

Option 1 ID : 4410094877248

Option 2 ID : 4410094877246

Option 3 ID : 4410094877249

Option 4 ID : 4410094877247

Status : Answered

Chosen Option : 4

Q.129 ଅବ୍ୟୟ ପଦ ବ୍ୟବହାର କରି ବାକ୍ୟଟିକୁ  ସମ୍ପୂର୍ଣ୍ଣ କର ।

''ସେ ବର୍ଷାରେ ____ ଆସିବ, ବଡ଼ ହଇରାଣ ହେବ ।''

Ans 1. କାଳେ

2. ଯେବେ

3. ଯଦି

4. ପ୍ରାୟ

Question Type : MCQ

Question ID : 4410091483726

Option 1 ID : 4410095861782

Option 2 ID : 4410095861783

Option 3 ID : 4410095861784

Option 4 ID : 4410095861781

Status : Answered

Chosen Option : 3
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Q.130 ବାକ୍ୟର ଅଂଶଗୁଡ଼ିକୁ  ସଠିକ କ୍ରମରେ ପୁନଃସଜ୍ଜିତ କରନ୍ତୁ ।

ହିରାକୁଦ ଡ୍ୟାମ
P. ଯାହାର ଲମ୍ବ ପ୍ରାୟ
Q. ମଧ୍ୟରୁ  ଅନ୍ୟତମ,

R. ପୃଥି ବୀର ଦୀର୍ଘତମ ମାଟି ବନ୍ଧ
S. 25.8 କିଲୋମିଟର ଅଟେ

Ans 1. SPQR

2. QRPS

3. PQSR

4. RQPS

Question Type : MCQ

Question ID : 4410091238291

Option 1 ID : 4410094886690

Option 2 ID : 4410094886691

Option 3 ID : 4410094886692

Option 4 ID : 4410094886693

Status : Answered

Chosen Option : 4

Q.131 ନିମ୍ନଲିଖି ତ ଶବ୍ଦଗୁଡ଼ିକର ସମାନାର୍ଥବୋଧକ ଶବ୍ଦ ଲେଖ।
"ଅଗ୍ନି" ଦେବତାଙ୍କୁ  ବେଦରେ ପବିତ୍ର ମନାଯାଇଛି।

Ans 1. ପୃଥିବୀ

2. ଜଳ

3. ଆଗ

4. ପବନ

Question Type : MCQ

Question ID : 4410091485508

Option 1 ID : 4410095868504

Option 2 ID : 4410095868501

Option 3 ID : 4410095868503

Option 4 ID : 4410095868502

Status : Answered

Chosen Option : 3
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Q.132 ନିମ୍ନଲିଖି ତ ଇଂରାଜୀ ବାକ୍ୟର ଠିକ୍ ଓଡିଆ ଅନୁବାଦ ବାଛ-

"We should not quarrel among one another in the name of religion".

Ans 1. ଧର୍ମ ନାମରେ ଆମେ ନିଜ ଭି ତରେ କଳହ କରିବା ଠିକ୍ ନୁ ହେଁ ।

2. ଧର୍ମ ନାମରେ ନିଜ ଭି ତରେ କଳହ କରିବା ଉଚିତ ନୁ ହେଁ ।

3. ଧର୍ମ ନାମରେ ଆମେ ନିଜ ନିଜ ଭି ତରେ କଳହ କରିବା ଉଚିତ ନୁ ହେଁ ।

4. ଧର୍ମ ନାମରେ ଆମେ କଳହ କରିବା ଉଚିତ ନୁ ହେଁ ।

Question Type : MCQ

Question ID : 4410091726020

Option 1 ID : 4410096807124

Option 2 ID : 4410096807126

Option 3 ID : 4410096807127

Option 4 ID : 4410096807125

Status : Answered

Chosen Option : 1

Q.133 ତୁମେ କାମ ଆରମ୍ଭ କରିବାର ଛଅ ଘଣ୍ଟା ବିତିଗଲାଣି । ଉକ୍ତ  ଓଡିଆ ବାକ୍ୟଟିର ଇଂରାଜୀ ଅନୁବାଦଟିକୁ  ଚୟନ
କର ।

Ans 1. Six hours have pass since you began the work.

2. Six hours have passed since you began the work.

3. Six hour have passed since you began the work.

4. Six hours have passed since you begin the work.

Question Type : MCQ

Question ID : 4410091729074

Option 1 ID : 4410096818837

Option 2 ID : 4410096818839

Option 3 ID : 4410096818838

Option 4 ID : 4410096818836

Status : Answered

Chosen Option : 2
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Q.134 ତତ୍ସମ ଶବ୍ଦର ଅର୍ଥ କ’ଣ ହେବ?

Ans 1. ଯେଉଁଗୁଡ଼ିକ ଅବିକୃତ ଭାବେ ସଂସ୍କୃ ତରୁ  ଗୃହୀତ

2. ଯେଉଁ ଶବ୍ଦଗୁଡିକ ଆଧୁନିକ

3. ଯେଉଁଗୁଡ଼ିକ ଦେଶୀ ଭାଷାରୁ  ଆସିଛି

4. ଯେଉଁ ଶବ୍ଦଗୁଡିକ ନୂତନ ସୃଷ୍ଟି

Question Type : MCQ

Question ID : 4410091235930

Option 1 ID : 4410094877303

Option 2 ID : 4410094877305

Option 3 ID : 4410094877302

Option 4 ID : 4410094877304

Status : Answered

Chosen Option : 1

Q.135 ଅବ୍ୟୟ ପଦ ବ୍ୟବହାର କରି ବାକ୍ୟଟିକୁ  ସମ୍ପୂର୍ଣ୍ଣ କର ।

''ନୀରଦ ____ ଭଲ ଗୁଣୀ ପିଲାଟିଏ ଦୁର୍ଲଭ ।''

Ans 1. ଅନୁଗମନ

2. ପରି

3. ସୁଗମନ

4. ଯଥା

Question Type : MCQ

Question ID : 4410091483721

Option 1 ID : 4410095861764

Option 2 ID : 4410095861763

Option 3 ID : 4410095861761

Option 4 ID : 4410095861762

Status : Answered

Chosen Option : 2
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Comprehension:

ନିମ୍ନୋକ୍ତ  ଅନୁ ଚ୍ଛେଦକୁ  ପଢି ସମସ୍ତ ପ୍ରଶ୍ନଗୁଡିକର ଉତ୍ତର ଚୟନ କର ।
ମନୁଷ୍ୟ ନିତାନ୍ତ ଭାବରେ ଗୋଷ୍ଠିକ ଜୀବ । ସେ ସ୍ଵତନ୍ତ୍ର  ରହିବାକୁ  ଚାହେଁ, କିନ୍ତୁ  ଏକା ରହିବାକୁ  ଚାହେଁନା । ଆମେ ଘରଟିଏ କରି ଚାରିପାଖ
ପାଖରେ ବାଡ଼ ବା ପାଚେରି ଘେରାଇ ଦେଉ; ଆମର ସ୍ୱକୀୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ ର ଜୟପତାକା ଉଡ଼ାଇ; କିନ୍ତୁ  ଯେତେ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଚାହିଁଲେ ମଧ୍ୟ କେହି ନିର୍ଜନ
ମରୁଭୂ ମିରେ ବା ଶ୍ମଶାନରେ ଘର କରେନା । କାରଣ ମନୁଷ୍ୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ  ଚାହେଁ, ତା ସଙ୍ଗେ ସଙ୍ଗେ ସାମୂହ୍ୟ ବି ଚାହେଁ । ସିନ୍ଧୁ ର ଅଗଣିତ ବିନ୍ଦୁ
ସିନ୍ଧୁ ରେ ମିଶିଗଲାପରି ସେ ନିଜର ସତ୍ତା ଭୁଲି  ଯିବାକୁ  ଚାହେଁନା । ସେ ସିନ୍ଧୁ ତ୍ୱ  ଚାହେଁ, ବିନ୍ଦୁ ତ୍ୱ  ମଧ୍ୟ ଚାହେଁ । ସମାଜର ପ୍ରତ୍ୟେକ ବ୍ୟକ୍ତି  ଅପର
ବ୍ୟକ୍ତିକୁ  ଅବିଶ୍ୱାସ ବା ହିଂସାର ଦୃଷ୍ଟିରେ ଦେଖିପାରେ ; କିନ୍ତୁ  ପ୍ରତ୍ୟେକ ସମଷ୍ଟି ଭାବରେ ସମାଜକୁ  ଚାହାଁନ୍ତି । ଏକତ୍ରିତ ଜନତାର ଏକ ସ୍ୱକୀୟ
ପ୍ରୟୋଜନ ଓ ସୌନ୍ଦର୍ଯ୍ୟ ଅଛି । ମେଳାରେ ଲୋକେ ଲୋକ‌କୁହିଁ ଦେଖୁବାକୁ  ଦୌଡ଼ନ୍ତି । ବ୍ୟକ୍ତି  ଓ ସମଷ୍ଟି ଗଛ ଓ ତା'ର ଡାଳପରି, ପରସ୍ପରର
ଅଙ୍ଗାଙ୍ଗୀ । ସମାଜର ଏକକ କୁଟୁମ୍ବ, କୁଟୁମ୍ବର କେନ୍ଦ୍ର  ନାରୀ । ଏବେବି ପୃଥବୀପୃଷ୍ଠରେ ଅନେକ ଗ୍ରାମ ଅଛି, ଯେଉଁଠି ସାରା ଗ୍ରାମଟି ଗୋଟିଏ
କୁଟୁମ୍ବ, ପୃଥ‌ିବୀ ପୃଷ୍ଠରେ ଅର୍ଥାତ୍ ଗୋଟିଏ ଯୁଗ୍ମରୁ  ପ୍ରସାରିତ, ଲକ୍ଷ ଲକ୍ଷ ବର୍ଷଧରି ଏକ ଏକ ନରନାରୀ ଯୁଦ୍ଧ ଯୁଗ୍ମରୁ  କୁଟୁମ୍ବର ସଂପ୍ରସାରଣ ହୋଇ
କୋଟି କୋଟି ସଂଖ୍ୟାରେ ଜାତି ଗଢ଼ି ଉଠିଛି । ପୁରାଣରେ ସେଥ‌ିପାଇଁ ଦିତି, ଅଦିତି ଦୁଇ ଭଉଣୀଠାରୁ  ଦୈତ୍ୟ ଓ ଦେବତାମାନଙ୍କର ଉଦ୍ଭବ ବର୍ଣ୍ଣିତ
ହୋଇଅଛି । ଇଂରେଜ ଓ ଜର୍ମାନ, ଗତ ଦୁଇଟି ମହାଯୁଦ୍ଧରେ ପରସ୍ପର ନାଗ-ନେଉଳପରି ଗଳା କଟାକଟି କଲେହେଁ ସେମାନଙ୍କର ରକ୍ତ  ଏକ । ବହୁ
ସହସ୍ର ବର୍ଷ ପୂର୍ବେ ସେମାନଙ୍କର ଜନନୀ ବୋଧହୁଏ ଏକ ଥିଲା । ସ୍ୱାର୍ଥ ଓ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଇଚ୍ଛା ଯୋଗୁ କୁଟୁମ୍ବ ଯେପରି ଫଡ଼ାଫଡ଼ା ହୁଏ, ସମାଜ ମଧ୍ୟ
ସେହିପରି ରାଷ୍ଟ୍ରରେ ବିଭକ୍ତ  ହୋଇ ଲଢ଼େଇ ପାଇଁ ତିଆର ହୁଏ । ଖ୍ରୀଷ୍ଟୀୟ ପୁରାଣ ଅନୁସାରେ ସମଗ୍ର ମାନବ ଜାତି ଆଡ଼ାମ୍ ଓ ଇଭ୍ ଏହି ଆଦିମ
ନରନାରୀ ଯୁଗ୍ମରୁ  ଉତ୍ପନ୍ନ  । ପୃଥ‌ିବୀର ଶତ ଶତ ଭି ନ୍ନ  ଭି ନ୍ନ  ଭାଷା, ଭି ନ୍ନ  ଭି ନ୍ନ  ଧର୍ମ, ଆଚାର, ବ୍ୟବହାର ପୁଣି ଚମଡ଼ାର ଭି ନ୍ନ  ଭି ନ୍ନ  ବର୍ଷ ଓ ଓ
ମୁଖମଣ୍ଡଳର ଗଠନ ବୈଚିତ୍ର ଦେଖିଲେ ବିଶ୍ଵାସ କରିବାକୁ  କଷ୍ଟ ହୁଏ ଯେ, ଆମେ ସମଗ୍ର ମାନବ ଜାତି ଏକ ବାପ ମା’ଠୁଁ  ଜାତ । ସେ ଯାହାହେଉ;

ଇତିହାସ ଆଲୋଚନା କଲେ ଏତିକି ଅନ୍ତତଃ ଜଣାପଡ଼ୁଛି ଯେ, ପୃଥ‌ିବୀରେ ଦିନେ ଏତେ ଧର୍ମ ନଥିଲା କି ଏତେ ଭାଷା ବି ନଥିଲା – ଯେଉଁ ଧର୍ମ ଓ
ଭାଷା ହିଁ ଆଜି ମନୁଷ୍ୟ ମନୁଷ୍ୟ ଭି ତରେ ସହସ୍ର ଅଲଂଘ୍ୟ ପାଚେରିର କାମ କରୁଛନ୍ତି । ଧର୍ମ ଓ ଭାଷାଗୁଡ଼ିକ ଗଣନୀୟ କାଳ ଭି ତରେହିଁ ଜନ୍ମ  ଓ
ଅଭି ବୃଦ୍ଧି ପାଇଛନ୍ତି । ଚତୁର୍ଦ୍ଦଶ ଶତାବ୍ଦୀ ପର୍ଯ୍ୟନ୍ତ ଇଉରୋପର ବିଶ୍ୱବିଖ୍ୟାତ ଭାଷାଗୁଡ଼ିକର ସତ୍ତାହିଁ ନଥିଲା । ଆଧୁନିକ ଭାରତର ଭାଷା ଗୁଡ଼ିକର
କଥାହିଁ ସେହିପରି । ବଙ୍ଗାଳୀ, ଓଡ଼ିଆ ଓ ବିହାରୀ ଛଅଶ ବର୍ଷ ତଳେ ଏକ ଭାଷାରେ କଥାଭାଷା ହେଉଥିଲେ । ଏବେ କିନ୍ତୁ  ନିଜ ନିଜର ସ୍ୱତନ୍ତ୍ର
ଭାଷାର ଦ୍ଵା ହି ଦେଇ ସେମାନେ ପରସ୍ପରର ମୁଣ୍ଡ ଫଟେଇବାକୁ  ସଦା ଜାଗ୍ରତ । ଧର୍ମର କଥାବି ସେହିପରି । ମାନବିକ ସଭ୍ୟତା ଅନ୍ତତଃ ସାତ
ହଜାର ବର୍ଷର; କିନ୍ତୁ  ଖ୍ରୀଷ୍ଟଧର୍ମର ଜନ୍ମ  ମାତ୍ର ୧୯ ଶହ ବର୍ଷ ତଳେ, ଇସ୍‌ଲାମ୍‌ର ବାର ଶହ ବର୍ଷ ତଳେ, କିନ୍ତୁ  ଏ ଦୁଇଟିଯାକ ଧର୍ମ ମନେକରନ୍ତି ଯେ
ଈଶ୍ଵର ତାଙ୍କୁ  ହିଁ ପ୍ରକୃତ ସତ୍ୟ ଓ ଜ୍ଞାନ ଦେଇଛନ୍ତି ଏବଂ ସେଥିପାଇଁ ଏ ଦୁଇଟି ଧର୍ମ ଯୋଗୁଁ ପୃଥ‌ିବୀରେ ଯେତେ ରକ୍ତପାତ ରାଜା ରାଜାର ଲଢ଼େଇ
ଯୋଗୁଁ ବୋଧହୁଏ ସେତେ ହୋଇନାହିଁ । ଧର୍ମ ଓ ଭାଷାକୁ  ଚିରନ୍ତନ ଓ ଅପରିବର୍ତ୍ତିତ ବା ଅପରିବର୍ତ୍ତନୀୟ ଘଟଣା ବୋଲି  ଧରି ସମାଜରେ କନ୍ଦଳ
ସୃଷ୍ଟି କରିବାକୁ  ତେଣୁ ଅନେକ ବୁଦ୍ଧିମାନ ଓ ବିଚାରବନ୍ତ ଲୋକ ଏବେ ଆଉ ପସନ୍ଦ କରନ୍ତି ନାହିଁ ।

SubQuestion No : 136

Q.136 ଉକ୍ତ  ଅନୁ ଚ୍ଛେଦଟି କେଉଁ ଧରଣର ରଚନା ?

Ans 1. ଜୀବନୀମୂଳକ

2. ତର୍କ ମୂଳକ

3. ଆଲୋଚନା ମୂଳକ

4. ବ୍ୟାଖ୍ୟା ମୂଳକ

Question Type : MCQ

Question ID : 4410091739102

Option 1 ID : 4410096858013

Option 2 ID : 4410096858011

Option 3 ID : 4410096858012

Option 4 ID : 4410096858014

Status : Answered

Chosen Option : 1
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Comprehension:

ନିମ୍ନୋକ୍ତ  ଅନୁ ଚ୍ଛେଦକୁ  ପଢି ସମସ୍ତ ପ୍ରଶ୍ନଗୁଡିକର ଉତ୍ତର ଚୟନ କର ।
ମନୁଷ୍ୟ ନିତାନ୍ତ ଭାବରେ ଗୋଷ୍ଠିକ ଜୀବ । ସେ ସ୍ଵତନ୍ତ୍ର  ରହିବାକୁ  ଚାହେଁ, କିନ୍ତୁ  ଏକା ରହିବାକୁ  ଚାହେଁନା । ଆମେ ଘରଟିଏ କରି ଚାରିପାଖ
ପାଖରେ ବାଡ଼ ବା ପାଚେରି ଘେରାଇ ଦେଉ; ଆମର ସ୍ୱକୀୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ ର ଜୟପତାକା ଉଡ଼ାଇ; କିନ୍ତୁ  ଯେତେ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଚାହିଁଲେ ମଧ୍ୟ କେହି ନିର୍ଜନ
ମରୁଭୂ ମିରେ ବା ଶ୍ମଶାନରେ ଘର କରେନା । କାରଣ ମନୁଷ୍ୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ  ଚାହେଁ, ତା ସଙ୍ଗେ ସଙ୍ଗେ ସାମୂହ୍ୟ ବି ଚାହେଁ । ସିନ୍ଧୁ ର ଅଗଣିତ ବିନ୍ଦୁ
ସିନ୍ଧୁ ରେ ମିଶିଗଲାପରି ସେ ନିଜର ସତ୍ତା ଭୁଲି  ଯିବାକୁ  ଚାହେଁନା । ସେ ସିନ୍ଧୁ ତ୍ୱ  ଚାହେଁ, ବିନ୍ଦୁ ତ୍ୱ  ମଧ୍ୟ ଚାହେଁ । ସମାଜର ପ୍ରତ୍ୟେକ ବ୍ୟକ୍ତି  ଅପର
ବ୍ୟକ୍ତିକୁ  ଅବିଶ୍ୱାସ ବା ହିଂସାର ଦୃଷ୍ଟିରେ ଦେଖିପାରେ ; କିନ୍ତୁ  ପ୍ରତ୍ୟେକ ସମଷ୍ଟି ଭାବରେ ସମାଜକୁ  ଚାହାଁନ୍ତି । ଏକତ୍ରିତ ଜନତାର ଏକ ସ୍ୱକୀୟ
ପ୍ରୟୋଜନ ଓ ସୌନ୍ଦର୍ଯ୍ୟ ଅଛି । ମେଳାରେ ଲୋକେ ଲୋକ‌କୁହିଁ ଦେଖୁବାକୁ  ଦୌଡ଼ନ୍ତି । ବ୍ୟକ୍ତି  ଓ ସମଷ୍ଟି ଗଛ ଓ ତା'ର ଡାଳପରି, ପରସ୍ପରର
ଅଙ୍ଗାଙ୍ଗୀ । ସମାଜର ଏକକ କୁଟୁମ୍ବ, କୁଟୁମ୍ବର କେନ୍ଦ୍ର  ନାରୀ । ଏବେବି ପୃଥବୀପୃଷ୍ଠରେ ଅନେକ ଗ୍ରାମ ଅଛି, ଯେଉଁଠି ସାରା ଗ୍ରାମଟି ଗୋଟିଏ
କୁଟୁମ୍ବ, ପୃଥ‌ିବୀ ପୃଷ୍ଠରେ ଅର୍ଥାତ୍ ଗୋଟିଏ ଯୁଗ୍ମରୁ  ପ୍ରସାରିତ, ଲକ୍ଷ ଲକ୍ଷ ବର୍ଷଧରି ଏକ ଏକ ନରନାରୀ ଯୁଦ୍ଧ ଯୁଗ୍ମରୁ  କୁଟୁମ୍ବର ସଂପ୍ରସାରଣ ହୋଇ
କୋଟି କୋଟି ସଂଖ୍ୟାରେ ଜାତି ଗଢ଼ି ଉଠିଛି । ପୁରାଣରେ ସେଥ‌ିପାଇଁ ଦିତି, ଅଦିତି ଦୁଇ ଭଉଣୀଠାରୁ  ଦୈତ୍ୟ ଓ ଦେବତାମାନଙ୍କର ଉଦ୍ଭବ ବର୍ଣ୍ଣିତ
ହୋଇଅଛି । ଇଂରେଜ ଓ ଜର୍ମାନ, ଗତ ଦୁଇଟି ମହାଯୁଦ୍ଧରେ ପରସ୍ପର ନାଗ-ନେଉଳପରି ଗଳା କଟାକଟି କଲେହେଁ ସେମାନଙ୍କର ରକ୍ତ  ଏକ । ବହୁ
ସହସ୍ର ବର୍ଷ ପୂର୍ବେ ସେମାନଙ୍କର ଜନନୀ ବୋଧହୁଏ ଏକ ଥିଲା । ସ୍ୱାର୍ଥ ଓ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଇଚ୍ଛା ଯୋଗୁ କୁଟୁମ୍ବ ଯେପରି ଫଡ଼ାଫଡ଼ା ହୁଏ, ସମାଜ ମଧ୍ୟ
ସେହିପରି ରାଷ୍ଟ୍ରରେ ବିଭକ୍ତ  ହୋଇ ଲଢ଼େଇ ପାଇଁ ତିଆର ହୁଏ । ଖ୍ରୀଷ୍ଟୀୟ ପୁରାଣ ଅନୁସାରେ ସମଗ୍ର ମାନବ ଜାତି ଆଡ଼ାମ୍ ଓ ଇଭ୍ ଏହି ଆଦିମ
ନରନାରୀ ଯୁଗ୍ମରୁ  ଉତ୍ପନ୍ନ  । ପୃଥ‌ିବୀର ଶତ ଶତ ଭି ନ୍ନ  ଭି ନ୍ନ  ଭାଷା, ଭି ନ୍ନ  ଭି ନ୍ନ  ଧର୍ମ, ଆଚାର, ବ୍ୟବହାର ପୁଣି ଚମଡ଼ାର ଭି ନ୍ନ  ଭି ନ୍ନ  ବର୍ଷ ଓ ଓ
ମୁଖମଣ୍ଡଳର ଗଠନ ବୈଚିତ୍ର ଦେଖିଲେ ବିଶ୍ଵାସ କରିବାକୁ  କଷ୍ଟ ହୁଏ ଯେ, ଆମେ ସମଗ୍ର ମାନବ ଜାତି ଏକ ବାପ ମା’ଠୁଁ  ଜାତ । ସେ ଯାହାହେଉ;

ଇତିହାସ ଆଲୋଚନା କଲେ ଏତିକି ଅନ୍ତତଃ ଜଣାପଡ଼ୁଛି ଯେ, ପୃଥ‌ିବୀରେ ଦିନେ ଏତେ ଧର୍ମ ନଥିଲା କି ଏତେ ଭାଷା ବି ନଥିଲା – ଯେଉଁ ଧର୍ମ ଓ
ଭାଷା ହିଁ ଆଜି ମନୁଷ୍ୟ ମନୁଷ୍ୟ ଭି ତରେ ସହସ୍ର ଅଲଂଘ୍ୟ ପାଚେରିର କାମ କରୁଛନ୍ତି । ଧର୍ମ ଓ ଭାଷାଗୁଡ଼ିକ ଗଣନୀୟ କାଳ ଭି ତରେହିଁ ଜନ୍ମ  ଓ
ଅଭି ବୃଦ୍ଧି ପାଇଛନ୍ତି । ଚତୁର୍ଦ୍ଦଶ ଶତାବ୍ଦୀ ପର୍ଯ୍ୟନ୍ତ ଇଉରୋପର ବିଶ୍ୱବିଖ୍ୟାତ ଭାଷାଗୁଡ଼ିକର ସତ୍ତାହିଁ ନଥିଲା । ଆଧୁନିକ ଭାରତର ଭାଷା ଗୁଡ଼ିକର
କଥାହିଁ ସେହିପରି । ବଙ୍ଗାଳୀ, ଓଡ଼ିଆ ଓ ବିହାରୀ ଛଅଶ ବର୍ଷ ତଳେ ଏକ ଭାଷାରେ କଥାଭାଷା ହେଉଥିଲେ । ଏବେ କିନ୍ତୁ  ନିଜ ନିଜର ସ୍ୱତନ୍ତ୍ର
ଭାଷାର ଦ୍ଵା ହି ଦେଇ ସେମାନେ ପରସ୍ପରର ମୁଣ୍ଡ ଫଟେଇବାକୁ  ସଦା ଜାଗ୍ରତ । ଧର୍ମର କଥାବି ସେହିପରି । ମାନବିକ ସଭ୍ୟତା ଅନ୍ତତଃ ସାତ
ହଜାର ବର୍ଷର; କିନ୍ତୁ  ଖ୍ରୀଷ୍ଟଧର୍ମର ଜନ୍ମ  ମାତ୍ର ୧୯ ଶହ ବର୍ଷ ତଳେ, ଇସ୍‌ଲାମ୍‌ର ବାର ଶହ ବର୍ଷ ତଳେ, କିନ୍ତୁ  ଏ ଦୁଇଟିଯାକ ଧର୍ମ ମନେକରନ୍ତି ଯେ
ଈଶ୍ଵର ତାଙ୍କୁ  ହିଁ ପ୍ରକୃତ ସତ୍ୟ ଓ ଜ୍ଞାନ ଦେଇଛନ୍ତି ଏବଂ ସେଥିପାଇଁ ଏ ଦୁଇଟି ଧର୍ମ ଯୋଗୁଁ ପୃଥ‌ିବୀରେ ଯେତେ ରକ୍ତପାତ ରାଜା ରାଜାର ଲଢ଼େଇ
ଯୋଗୁଁ ବୋଧହୁଏ ସେତେ ହୋଇନାହିଁ । ଧର୍ମ ଓ ଭାଷାକୁ  ଚିରନ୍ତନ ଓ ଅପରିବର୍ତ୍ତିତ ବା ଅପରିବର୍ତ୍ତନୀୟ ଘଟଣା ବୋଲି  ଧରି ସମାଜରେ କନ୍ଦଳ
ସୃଷ୍ଟି କରିବାକୁ  ତେଣୁ ଅନେକ ବୁଦ୍ଧିମାନ ଓ ବିଚାରବନ୍ତ ଲୋକ ଏବେ ଆଉ ପସନ୍ଦ କରନ୍ତି ନାହିଁ ।

SubQuestion No : 137

Q.137 ଅନୁ ଚ୍ଛେଦର ମୁଖ୍ୟ ଭାବ କଣ ?

Ans 1. ପ୍ରାକୃତିକ ସୌନ୍ଦର୍ଯ୍ୟର ବର୍ଣ୍ଣନା

2. ସମାଜରେ ଧର୍ମ, ଆଚାର ଓ ମୂଲ୍ୟବୋଧ

3. ଐତିହାସିକ ଘଟଣାର ବିବରଣୀ

4. ଆର୍ଥିକ ବିକାଶର ଆଲୋଚନା

Question Type : MCQ

Question ID : 4410091739103

Option 1 ID : 4410096858015

Option 2 ID : 4410096858017

Option 3 ID : 4410096858018

Option 4 ID : 4410096858016
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Comprehension:

ନିମ୍ନୋକ୍ତ  ଅନୁ ଚ୍ଛେଦକୁ  ପଢି ସମସ୍ତ ପ୍ରଶ୍ନଗୁଡିକର ଉତ୍ତର ଚୟନ କର ।
ମନୁଷ୍ୟ ନିତାନ୍ତ ଭାବରେ ଗୋଷ୍ଠିକ ଜୀବ । ସେ ସ୍ଵତନ୍ତ୍ର  ରହିବାକୁ  ଚାହେଁ, କିନ୍ତୁ  ଏକା ରହିବାକୁ  ଚାହେଁନା । ଆମେ ଘରଟିଏ କରି ଚାରିପାଖ
ପାଖରେ ବାଡ଼ ବା ପାଚେରି ଘେରାଇ ଦେଉ; ଆମର ସ୍ୱକୀୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ ର ଜୟପତାକା ଉଡ଼ାଇ; କିନ୍ତୁ  ଯେତେ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଚାହିଁଲେ ମଧ୍ୟ କେହି ନିର୍ଜନ
ମରୁଭୂ ମିରେ ବା ଶ୍ମଶାନରେ ଘର କରେନା । କାରଣ ମନୁଷ୍ୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ  ଚାହେଁ, ତା ସଙ୍ଗେ ସଙ୍ଗେ ସାମୂହ୍ୟ ବି ଚାହେଁ । ସିନ୍ଧୁ ର ଅଗଣିତ ବିନ୍ଦୁ
ସିନ୍ଧୁ ରେ ମିଶିଗଲାପରି ସେ ନିଜର ସତ୍ତା ଭୁଲି  ଯିବାକୁ  ଚାହେଁନା । ସେ ସିନ୍ଧୁ ତ୍ୱ  ଚାହେଁ, ବିନ୍ଦୁ ତ୍ୱ  ମଧ୍ୟ ଚାହେଁ । ସମାଜର ପ୍ରତ୍ୟେକ ବ୍ୟକ୍ତି  ଅପର
ବ୍ୟକ୍ତିକୁ  ଅବିଶ୍ୱାସ ବା ହିଂସାର ଦୃଷ୍ଟିରେ ଦେଖିପାରେ ; କିନ୍ତୁ  ପ୍ରତ୍ୟେକ ସମଷ୍ଟି ଭାବରେ ସମାଜକୁ  ଚାହାଁନ୍ତି । ଏକତ୍ରିତ ଜନତାର ଏକ ସ୍ୱକୀୟ
ପ୍ରୟୋଜନ ଓ ସୌନ୍ଦର୍ଯ୍ୟ ଅଛି । ମେଳାରେ ଲୋକେ ଲୋକ‌କୁହିଁ ଦେଖୁବାକୁ  ଦୌଡ଼ନ୍ତି । ବ୍ୟକ୍ତି  ଓ ସମଷ୍ଟି ଗଛ ଓ ତା'ର ଡାଳପରି, ପରସ୍ପରର
ଅଙ୍ଗାଙ୍ଗୀ । ସମାଜର ଏକକ କୁଟୁମ୍ବ, କୁଟୁମ୍ବର କେନ୍ଦ୍ର  ନାରୀ । ଏବେବି ପୃଥବୀପୃଷ୍ଠରେ ଅନେକ ଗ୍ରାମ ଅଛି, ଯେଉଁଠି ସାରା ଗ୍ରାମଟି ଗୋଟିଏ
କୁଟୁମ୍ବ, ପୃଥ‌ିବୀ ପୃଷ୍ଠରେ ଅର୍ଥାତ୍ ଗୋଟିଏ ଯୁଗ୍ମରୁ  ପ୍ରସାରିତ, ଲକ୍ଷ ଲକ୍ଷ ବର୍ଷଧରି ଏକ ଏକ ନରନାରୀ ଯୁଦ୍ଧ ଯୁଗ୍ମରୁ  କୁଟୁମ୍ବର ସଂପ୍ରସାରଣ ହୋଇ
କୋଟି କୋଟି ସଂଖ୍ୟାରେ ଜାତି ଗଢ଼ି ଉଠିଛି । ପୁରାଣରେ ସେଥ‌ିପାଇଁ ଦିତି, ଅଦିତି ଦୁଇ ଭଉଣୀଠାରୁ  ଦୈତ୍ୟ ଓ ଦେବତାମାନଙ୍କର ଉଦ୍ଭବ ବର୍ଣ୍ଣିତ
ହୋଇଅଛି । ଇଂରେଜ ଓ ଜର୍ମାନ, ଗତ ଦୁଇଟି ମହାଯୁଦ୍ଧରେ ପରସ୍ପର ନାଗ-ନେଉଳପରି ଗଳା କଟାକଟି କଲେହେଁ ସେମାନଙ୍କର ରକ୍ତ  ଏକ । ବହୁ
ସହସ୍ର ବର୍ଷ ପୂର୍ବେ ସେମାନଙ୍କର ଜନନୀ ବୋଧହୁଏ ଏକ ଥିଲା । ସ୍ୱାର୍ଥ ଓ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଇଚ୍ଛା ଯୋଗୁ କୁଟୁମ୍ବ ଯେପରି ଫଡ଼ାଫଡ଼ା ହୁଏ, ସମାଜ ମଧ୍ୟ
ସେହିପରି ରାଷ୍ଟ୍ରରେ ବିଭକ୍ତ  ହୋଇ ଲଢ଼େଇ ପାଇଁ ତିଆର ହୁଏ । ଖ୍ରୀଷ୍ଟୀୟ ପୁରାଣ ଅନୁସାରେ ସମଗ୍ର ମାନବ ଜାତି ଆଡ଼ାମ୍ ଓ ଇଭ୍ ଏହି ଆଦିମ
ନରନାରୀ ଯୁଗ୍ମରୁ  ଉତ୍ପନ୍ନ  । ପୃଥ‌ିବୀର ଶତ ଶତ ଭି ନ୍ନ  ଭି ନ୍ନ  ଭାଷା, ଭି ନ୍ନ  ଭି ନ୍ନ  ଧର୍ମ, ଆଚାର, ବ୍ୟବହାର ପୁଣି ଚମଡ଼ାର ଭି ନ୍ନ  ଭି ନ୍ନ  ବର୍ଷ ଓ ଓ
ମୁଖମଣ୍ଡଳର ଗଠନ ବୈଚିତ୍ର ଦେଖିଲେ ବିଶ୍ଵାସ କରିବାକୁ  କଷ୍ଟ ହୁଏ ଯେ, ଆମେ ସମଗ୍ର ମାନବ ଜାତି ଏକ ବାପ ମା’ଠୁଁ  ଜାତ । ସେ ଯାହାହେଉ;

ଇତିହାସ ଆଲୋଚନା କଲେ ଏତିକି ଅନ୍ତତଃ ଜଣାପଡ଼ୁଛି ଯେ, ପୃଥ‌ିବୀରେ ଦିନେ ଏତେ ଧର୍ମ ନଥିଲା କି ଏତେ ଭାଷା ବି ନଥିଲା – ଯେଉଁ ଧର୍ମ ଓ
ଭାଷା ହିଁ ଆଜି ମନୁଷ୍ୟ ମନୁଷ୍ୟ ଭି ତରେ ସହସ୍ର ଅଲଂଘ୍ୟ ପାଚେରିର କାମ କରୁଛନ୍ତି । ଧର୍ମ ଓ ଭାଷାଗୁଡ଼ିକ ଗଣନୀୟ କାଳ ଭି ତରେହିଁ ଜନ୍ମ  ଓ
ଅଭି ବୃଦ୍ଧି ପାଇଛନ୍ତି । ଚତୁର୍ଦ୍ଦଶ ଶତାବ୍ଦୀ ପର୍ଯ୍ୟନ୍ତ ଇଉରୋପର ବିଶ୍ୱବିଖ୍ୟାତ ଭାଷାଗୁଡ଼ିକର ସତ୍ତାହିଁ ନଥିଲା । ଆଧୁନିକ ଭାରତର ଭାଷା ଗୁଡ଼ିକର
କଥାହିଁ ସେହିପରି । ବଙ୍ଗାଳୀ, ଓଡ଼ିଆ ଓ ବିହାରୀ ଛଅଶ ବର୍ଷ ତଳେ ଏକ ଭାଷାରେ କଥାଭାଷା ହେଉଥିଲେ । ଏବେ କିନ୍ତୁ  ନିଜ ନିଜର ସ୍ୱତନ୍ତ୍ର
ଭାଷାର ଦ୍ଵା ହି ଦେଇ ସେମାନେ ପରସ୍ପରର ମୁଣ୍ଡ ଫଟେଇବାକୁ  ସଦା ଜାଗ୍ରତ । ଧର୍ମର କଥାବି ସେହିପରି । ମାନବିକ ସଭ୍ୟତା ଅନ୍ତତଃ ସାତ
ହଜାର ବର୍ଷର; କିନ୍ତୁ  ଖ୍ରୀଷ୍ଟଧର୍ମର ଜନ୍ମ  ମାତ୍ର ୧୯ ଶହ ବର୍ଷ ତଳେ, ଇସ୍‌ଲାମ୍‌ର ବାର ଶହ ବର୍ଷ ତଳେ, କିନ୍ତୁ  ଏ ଦୁଇଟିଯାକ ଧର୍ମ ମନେକରନ୍ତି ଯେ
ଈଶ୍ଵର ତାଙ୍କୁ  ହିଁ ପ୍ରକୃତ ସତ୍ୟ ଓ ଜ୍ଞାନ ଦେଇଛନ୍ତି ଏବଂ ସେଥିପାଇଁ ଏ ଦୁଇଟି ଧର୍ମ ଯୋଗୁଁ ପୃଥ‌ିବୀରେ ଯେତେ ରକ୍ତପାତ ରାଜା ରାଜାର ଲଢ଼େଇ
ଯୋଗୁଁ ବୋଧହୁଏ ସେତେ ହୋଇନାହିଁ । ଧର୍ମ ଓ ଭାଷାକୁ  ଚିରନ୍ତନ ଓ ଅପରିବର୍ତ୍ତିତ ବା ଅପରିବର୍ତ୍ତନୀୟ ଘଟଣା ବୋଲି  ଧରି ସମାଜରେ କନ୍ଦଳ
ସୃଷ୍ଟି କରିବାକୁ  ତେଣୁ ଅନେକ ବୁଦ୍ଧିମାନ ଓ ବିଚାରବନ୍ତ ଲୋକ ଏବେ ଆଉ ପସନ୍ଦ କରନ୍ତି ନାହିଁ ।

SubQuestion No : 138

Q.138 ଅନୁ ଚ୍ଛେଦର ସଠିକ୍ ଶୀର୍ଷକ କେଉଁଟି ?
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Comprehension:

ନିମ୍ନୋକ୍ତ  ଅନୁ ଚ୍ଛେଦକୁ  ପଢି ସମସ୍ତ ପ୍ରଶ୍ନଗୁଡିକର ଉତ୍ତର ଚୟନ କର ।
ମନୁଷ୍ୟ ନିତାନ୍ତ ଭାବରେ ଗୋଷ୍ଠିକ ଜୀବ । ସେ ସ୍ଵତନ୍ତ୍ର  ରହିବାକୁ  ଚାହେଁ, କିନ୍ତୁ  ଏକା ରହିବାକୁ  ଚାହେଁନା । ଆମେ ଘରଟିଏ କରି ଚାରିପାଖ
ପାଖରେ ବାଡ଼ ବା ପାଚେରି ଘେରାଇ ଦେଉ; ଆମର ସ୍ୱକୀୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ ର ଜୟପତାକା ଉଡ଼ାଇ; କିନ୍ତୁ  ଯେତେ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଚାହିଁଲେ ମଧ୍ୟ କେହି ନିର୍ଜନ
ମରୁଭୂ ମିରେ ବା ଶ୍ମଶାନରେ ଘର କରେନା । କାରଣ ମନୁଷ୍ୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ  ଚାହେଁ, ତା ସଙ୍ଗେ ସଙ୍ଗେ ସାମୂହ୍ୟ ବି ଚାହେଁ । ସିନ୍ଧୁ ର ଅଗଣିତ ବିନ୍ଦୁ
ସିନ୍ଧୁ ରେ ମିଶିଗଲାପରି ସେ ନିଜର ସତ୍ତା ଭୁଲି  ଯିବାକୁ  ଚାହେଁନା । ସେ ସିନ୍ଧୁ ତ୍ୱ  ଚାହେଁ, ବିନ୍ଦୁ ତ୍ୱ  ମଧ୍ୟ ଚାହେଁ । ସମାଜର ପ୍ରତ୍ୟେକ ବ୍ୟକ୍ତି  ଅପର
ବ୍ୟକ୍ତିକୁ  ଅବିଶ୍ୱାସ ବା ହିଂସାର ଦୃଷ୍ଟିରେ ଦେଖିପାରେ ; କିନ୍ତୁ  ପ୍ରତ୍ୟେକ ସମଷ୍ଟି ଭାବରେ ସମାଜକୁ  ଚାହାଁନ୍ତି । ଏକତ୍ରିତ ଜନତାର ଏକ ସ୍ୱକୀୟ
ପ୍ରୟୋଜନ ଓ ସୌନ୍ଦର୍ଯ୍ୟ ଅଛି । ମେଳାରେ ଲୋକେ ଲୋକ‌କୁହିଁ ଦେଖୁବାକୁ  ଦୌଡ଼ନ୍ତି । ବ୍ୟକ୍ତି  ଓ ସମଷ୍ଟି ଗଛ ଓ ତା'ର ଡାଳପରି, ପରସ୍ପରର
ଅଙ୍ଗାଙ୍ଗୀ । ସମାଜର ଏକକ କୁଟୁମ୍ବ, କୁଟୁମ୍ବର କେନ୍ଦ୍ର  ନାରୀ । ଏବେବି ପୃଥବୀପୃଷ୍ଠରେ ଅନେକ ଗ୍ରାମ ଅଛି, ଯେଉଁଠି ସାରା ଗ୍ରାମଟି ଗୋଟିଏ
କୁଟୁମ୍ବ, ପୃଥ‌ିବୀ ପୃଷ୍ଠରେ ଅର୍ଥାତ୍ ଗୋଟିଏ ଯୁଗ୍ମରୁ  ପ୍ରସାରିତ, ଲକ୍ଷ ଲକ୍ଷ ବର୍ଷଧରି ଏକ ଏକ ନରନାରୀ ଯୁଦ୍ଧ ଯୁଗ୍ମରୁ  କୁଟୁମ୍ବର ସଂପ୍ରସାରଣ ହୋଇ
କୋଟି କୋଟି ସଂଖ୍ୟାରେ ଜାତି ଗଢ଼ି ଉଠିଛି । ପୁରାଣରେ ସେଥ‌ିପାଇଁ ଦିତି, ଅଦିତି ଦୁଇ ଭଉଣୀଠାରୁ  ଦୈତ୍ୟ ଓ ଦେବତାମାନଙ୍କର ଉଦ୍ଭବ ବର୍ଣ୍ଣିତ
ହୋଇଅଛି । ଇଂରେଜ ଓ ଜର୍ମାନ, ଗତ ଦୁଇଟି ମହାଯୁଦ୍ଧରେ ପରସ୍ପର ନାଗ-ନେଉଳପରି ଗଳା କଟାକଟି କଲେହେଁ ସେମାନଙ୍କର ରକ୍ତ  ଏକ । ବହୁ
ସହସ୍ର ବର୍ଷ ପୂର୍ବେ ସେମାନଙ୍କର ଜନନୀ ବୋଧହୁଏ ଏକ ଥିଲା । ସ୍ୱାର୍ଥ ଓ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଇଚ୍ଛା ଯୋଗୁ କୁଟୁମ୍ବ ଯେପରି ଫଡ଼ାଫଡ଼ା ହୁଏ, ସମାଜ ମଧ୍ୟ
ସେହିପରି ରାଷ୍ଟ୍ରରେ ବିଭକ୍ତ  ହୋଇ ଲଢ଼େଇ ପାଇଁ ତିଆର ହୁଏ । ଖ୍ରୀଷ୍ଟୀୟ ପୁରାଣ ଅନୁସାରେ ସମଗ୍ର ମାନବ ଜାତି ଆଡ଼ାମ୍ ଓ ଇଭ୍ ଏହି ଆଦିମ
ନରନାରୀ ଯୁଗ୍ମରୁ  ଉତ୍ପନ୍ନ  । ପୃଥ‌ିବୀର ଶତ ଶତ ଭି ନ୍ନ  ଭି ନ୍ନ  ଭାଷା, ଭି ନ୍ନ  ଭି ନ୍ନ  ଧର୍ମ, ଆଚାର, ବ୍ୟବହାର ପୁଣି ଚମଡ଼ାର ଭି ନ୍ନ  ଭି ନ୍ନ  ବର୍ଷ ଓ ଓ
ମୁଖମଣ୍ଡଳର ଗଠନ ବୈଚିତ୍ର ଦେଖିଲେ ବିଶ୍ଵାସ କରିବାକୁ  କଷ୍ଟ ହୁଏ ଯେ, ଆମେ ସମଗ୍ର ମାନବ ଜାତି ଏକ ବାପ ମା’ଠୁଁ  ଜାତ । ସେ ଯାହାହେଉ;

ଇତିହାସ ଆଲୋଚନା କଲେ ଏତିକି ଅନ୍ତତଃ ଜଣାପଡ଼ୁଛି ଯେ, ପୃଥ‌ିବୀରେ ଦିନେ ଏତେ ଧର୍ମ ନଥିଲା କି ଏତେ ଭାଷା ବି ନଥିଲା – ଯେଉଁ ଧର୍ମ ଓ
ଭାଷା ହିଁ ଆଜି ମନୁଷ୍ୟ ମନୁଷ୍ୟ ଭି ତରେ ସହସ୍ର ଅଲଂଘ୍ୟ ପାଚେରିର କାମ କରୁଛନ୍ତି । ଧର୍ମ ଓ ଭାଷାଗୁଡ଼ିକ ଗଣନୀୟ କାଳ ଭି ତରେହିଁ ଜନ୍ମ  ଓ
ଅଭି ବୃଦ୍ଧି ପାଇଛନ୍ତି । ଚତୁର୍ଦ୍ଦଶ ଶତାବ୍ଦୀ ପର୍ଯ୍ୟନ୍ତ ଇଉରୋପର ବିଶ୍ୱବିଖ୍ୟାତ ଭାଷାଗୁଡ଼ିକର ସତ୍ତାହିଁ ନଥିଲା । ଆଧୁନିକ ଭାରତର ଭାଷା ଗୁଡ଼ିକର
କଥାହିଁ ସେହିପରି । ବଙ୍ଗାଳୀ, ଓଡ଼ିଆ ଓ ବିହାରୀ ଛଅଶ ବର୍ଷ ତଳେ ଏକ ଭାଷାରେ କଥାଭାଷା ହେଉଥିଲେ । ଏବେ କିନ୍ତୁ  ନିଜ ନିଜର ସ୍ୱତନ୍ତ୍ର
ଭାଷାର ଦ୍ଵା ହି ଦେଇ ସେମାନେ ପରସ୍ପରର ମୁଣ୍ଡ ଫଟେଇବାକୁ  ସଦା ଜାଗ୍ରତ । ଧର୍ମର କଥାବି ସେହିପରି । ମାନବିକ ସଭ୍ୟତା ଅନ୍ତତଃ ସାତ
ହଜାର ବର୍ଷର; କିନ୍ତୁ  ଖ୍ରୀଷ୍ଟଧର୍ମର ଜନ୍ମ  ମାତ୍ର ୧୯ ଶହ ବର୍ଷ ତଳେ, ଇସ୍‌ଲାମ୍‌ର ବାର ଶହ ବର୍ଷ ତଳେ, କିନ୍ତୁ  ଏ ଦୁଇଟିଯାକ ଧର୍ମ ମନେକରନ୍ତି ଯେ
ଈଶ୍ଵର ତାଙ୍କୁ  ହିଁ ପ୍ରକୃତ ସତ୍ୟ ଓ ଜ୍ଞାନ ଦେଇଛନ୍ତି ଏବଂ ସେଥିପାଇଁ ଏ ଦୁଇଟି ଧର୍ମ ଯୋଗୁଁ ପୃଥ‌ିବୀରେ ଯେତେ ରକ୍ତପାତ ରାଜା ରାଜାର ଲଢ଼େଇ
ଯୋଗୁଁ ବୋଧହୁଏ ସେତେ ହୋଇନାହିଁ । ଧର୍ମ ଓ ଭାଷାକୁ  ଚିରନ୍ତନ ଓ ଅପରିବର୍ତ୍ତିତ ବା ଅପରିବର୍ତ୍ତନୀୟ ଘଟଣା ବୋଲି  ଧରି ସମାଜରେ କନ୍ଦଳ
ସୃଷ୍ଟି କରିବାକୁ  ତେଣୁ ଅନେକ ବୁଦ୍ଧିମାନ ଓ ବିଚାରବନ୍ତ ଲୋକ ଏବେ ଆଉ ପସନ୍ଦ କରନ୍ତି ନାହିଁ ।
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Comprehension:

ନିମ୍ନୋକ୍ତ  ଅନୁ ଚ୍ଛେଦକୁ  ପଢି ସମସ୍ତ ପ୍ରଶ୍ନଗୁଡିକର ଉତ୍ତର ଚୟନ କର ।
ମନୁଷ୍ୟ ନିତାନ୍ତ ଭାବରେ ଗୋଷ୍ଠିକ ଜୀବ । ସେ ସ୍ଵତନ୍ତ୍ର  ରହିବାକୁ  ଚାହେଁ, କିନ୍ତୁ  ଏକା ରହିବାକୁ  ଚାହେଁନା । ଆମେ ଘରଟିଏ କରି ଚାରିପାଖ
ପାଖରେ ବାଡ଼ ବା ପାଚେରି ଘେରାଇ ଦେଉ; ଆମର ସ୍ୱକୀୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ ର ଜୟପତାକା ଉଡ଼ାଇ; କିନ୍ତୁ  ଯେତେ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଚାହିଁଲେ ମଧ୍ୟ କେହି ନିର୍ଜନ
ମରୁଭୂ ମିରେ ବା ଶ୍ମଶାନରେ ଘର କରେନା । କାରଣ ମନୁଷ୍ୟ ସ୍ୱାତନ୍ତ୍ର୍ୟ  ଚାହେଁ, ତା ସଙ୍ଗେ ସଙ୍ଗେ ସାମୂହ୍ୟ ବି ଚାହେଁ । ସିନ୍ଧୁ ର ଅଗଣିତ ବିନ୍ଦୁ
ସିନ୍ଧୁ ରେ ମିଶିଗଲାପରି ସେ ନିଜର ସତ୍ତା ଭୁଲି  ଯିବାକୁ  ଚାହେଁନା । ସେ ସିନ୍ଧୁ ତ୍ୱ  ଚାହେଁ, ବିନ୍ଦୁ ତ୍ୱ  ମଧ୍ୟ ଚାହେଁ । ସମାଜର ପ୍ରତ୍ୟେକ ବ୍ୟକ୍ତି  ଅପର
ବ୍ୟକ୍ତିକୁ  ଅବିଶ୍ୱାସ ବା ହିଂସାର ଦୃଷ୍ଟିରେ ଦେଖିପାରେ ; କିନ୍ତୁ  ପ୍ରତ୍ୟେକ ସମଷ୍ଟି ଭାବରେ ସମାଜକୁ  ଚାହାଁନ୍ତି । ଏକତ୍ରିତ ଜନତାର ଏକ ସ୍ୱକୀୟ
ପ୍ରୟୋଜନ ଓ ସୌନ୍ଦର୍ଯ୍ୟ ଅଛି । ମେଳାରେ ଲୋକେ ଲୋକ‌କୁହିଁ ଦେଖୁବାକୁ  ଦୌଡ଼ନ୍ତି । ବ୍ୟକ୍ତି  ଓ ସମଷ୍ଟି ଗଛ ଓ ତା'ର ଡାଳପରି, ପରସ୍ପରର
ଅଙ୍ଗାଙ୍ଗୀ । ସମାଜର ଏକକ କୁଟୁମ୍ବ, କୁଟୁମ୍ବର କେନ୍ଦ୍ର  ନାରୀ । ଏବେବି ପୃଥବୀପୃଷ୍ଠରେ ଅନେକ ଗ୍ରାମ ଅଛି, ଯେଉଁଠି ସାରା ଗ୍ରାମଟି ଗୋଟିଏ
କୁଟୁମ୍ବ, ପୃଥ‌ିବୀ ପୃଷ୍ଠରେ ଅର୍ଥାତ୍ ଗୋଟିଏ ଯୁଗ୍ମରୁ  ପ୍ରସାରିତ, ଲକ୍ଷ ଲକ୍ଷ ବର୍ଷଧରି ଏକ ଏକ ନରନାରୀ ଯୁଦ୍ଧ ଯୁଗ୍ମରୁ  କୁଟୁମ୍ବର ସଂପ୍ରସାରଣ ହୋଇ
କୋଟି କୋଟି ସଂଖ୍ୟାରେ ଜାତି ଗଢ଼ି ଉଠିଛି । ପୁରାଣରେ ସେଥ‌ିପାଇଁ ଦିତି, ଅଦିତି ଦୁଇ ଭଉଣୀଠାରୁ  ଦୈତ୍ୟ ଓ ଦେବତାମାନଙ୍କର ଉଦ୍ଭବ ବର୍ଣ୍ଣିତ
ହୋଇଅଛି । ଇଂରେଜ ଓ ଜର୍ମାନ, ଗତ ଦୁଇଟି ମହାଯୁଦ୍ଧରେ ପରସ୍ପର ନାଗ-ନେଉଳପରି ଗଳା କଟାକଟି କଲେହେଁ ସେମାନଙ୍କର ରକ୍ତ  ଏକ । ବହୁ
ସହସ୍ର ବର୍ଷ ପୂର୍ବେ ସେମାନଙ୍କର ଜନନୀ ବୋଧହୁଏ ଏକ ଥିଲା । ସ୍ୱାର୍ଥ ଓ ସ୍ଵାତନ୍ତ୍ର୍ୟ  ଇଚ୍ଛା ଯୋଗୁ କୁଟୁମ୍ବ ଯେପରି ଫଡ଼ାଫଡ଼ା ହୁଏ, ସମାଜ ମଧ୍ୟ
ସେହିପରି ରାଷ୍ଟ୍ରରେ ବିଭକ୍ତ  ହୋଇ ଲଢ଼େଇ ପାଇଁ ତିଆର ହୁଏ । ଖ୍ରୀଷ୍ଟୀୟ ପୁରାଣ ଅନୁସାରେ ସମଗ୍ର ମାନବ ଜାତି ଆଡ଼ାମ୍ ଓ ଇଭ୍ ଏହି ଆଦିମ
ନରନାରୀ ଯୁଗ୍ମରୁ  ଉତ୍ପନ୍ନ  । ପୃଥ‌ିବୀର ଶତ ଶତ ଭି ନ୍ନ  ଭି ନ୍ନ  ଭାଷା, ଭି ନ୍ନ  ଭି ନ୍ନ  ଧର୍ମ, ଆଚାର, ବ୍ୟବହାର ପୁଣି ଚମଡ଼ାର ଭି ନ୍ନ  ଭି ନ୍ନ  ବର୍ଷ ଓ ଓ
ମୁଖମଣ୍ଡଳର ଗଠନ ବୈଚିତ୍ର ଦେଖିଲେ ବିଶ୍ଵାସ କରିବାକୁ  କଷ୍ଟ ହୁଏ ଯେ, ଆମେ ସମଗ୍ର ମାନବ ଜାତି ଏକ ବାପ ମା’ଠୁଁ  ଜାତ । ସେ ଯାହାହେଉ;

ଇତିହାସ ଆଲୋଚନା କଲେ ଏତିକି ଅନ୍ତତଃ ଜଣାପଡ଼ୁଛି ଯେ, ପୃଥ‌ିବୀରେ ଦିନେ ଏତେ ଧର୍ମ ନଥିଲା କି ଏତେ ଭାଷା ବି ନଥିଲା – ଯେଉଁ ଧର୍ମ ଓ
ଭାଷା ହିଁ ଆଜି ମନୁଷ୍ୟ ମନୁଷ୍ୟ ଭି ତରେ ସହସ୍ର ଅଲଂଘ୍ୟ ପାଚେରିର କାମ କରୁଛନ୍ତି । ଧର୍ମ ଓ ଭାଷାଗୁଡ଼ିକ ଗଣନୀୟ କାଳ ଭି ତରେହିଁ ଜନ୍ମ  ଓ
ଅଭି ବୃଦ୍ଧି ପାଇଛନ୍ତି । ଚତୁର୍ଦ୍ଦଶ ଶତାବ୍ଦୀ ପର୍ଯ୍ୟନ୍ତ ଇଉରୋପର ବିଶ୍ୱବିଖ୍ୟାତ ଭାଷାଗୁଡ଼ିକର ସତ୍ତାହିଁ ନଥିଲା । ଆଧୁନିକ ଭାରତର ଭାଷା ଗୁଡ଼ିକର
କଥାହିଁ ସେହିପରି । ବଙ୍ଗାଳୀ, ଓଡ଼ିଆ ଓ ବିହାରୀ ଛଅଶ ବର୍ଷ ତଳେ ଏକ ଭାଷାରେ କଥାଭାଷା ହେଉଥିଲେ । ଏବେ କିନ୍ତୁ  ନିଜ ନିଜର ସ୍ୱତନ୍ତ୍ର
ଭାଷାର ଦ୍ଵା ହି ଦେଇ ସେମାନେ ପରସ୍ପରର ମୁଣ୍ଡ ଫଟେଇବାକୁ  ସଦା ଜାଗ୍ରତ । ଧର୍ମର କଥାବି ସେହିପରି । ମାନବିକ ସଭ୍ୟତା ଅନ୍ତତଃ ସାତ
ହଜାର ବର୍ଷର; କିନ୍ତୁ  ଖ୍ରୀଷ୍ଟଧର୍ମର ଜନ୍ମ  ମାତ୍ର ୧୯ ଶହ ବର୍ଷ ତଳେ, ଇସ୍‌ଲାମ୍‌ର ବାର ଶହ ବର୍ଷ ତଳେ, କିନ୍ତୁ  ଏ ଦୁଇଟିଯାକ ଧର୍ମ ମନେକରନ୍ତି ଯେ
ଈଶ୍ଵର ତାଙ୍କୁ  ହିଁ ପ୍ରକୃତ ସତ୍ୟ ଓ ଜ୍ଞାନ ଦେଇଛନ୍ତି ଏବଂ ସେଥିପାଇଁ ଏ ଦୁଇଟି ଧର୍ମ ଯୋଗୁଁ ପୃଥ‌ିବୀରେ ଯେତେ ରକ୍ତପାତ ରାଜା ରାଜାର ଲଢ଼େଇ
ଯୋଗୁଁ ବୋଧହୁଏ ସେତେ ହୋଇନାହିଁ । ଧର୍ମ ଓ ଭାଷାକୁ  ଚିରନ୍ତନ ଓ ଅପରିବର୍ତ୍ତିତ ବା ଅପରିବର୍ତ୍ତନୀୟ ଘଟଣା ବୋଲି  ଧରି ସମାଜରେ କନ୍ଦଳ
ସୃଷ୍ଟି କରିବାକୁ  ତେଣୁ ଅନେକ ବୁଦ୍ଧିମାନ ଓ ବିଚାରବନ୍ତ ଲୋକ ଏବେ ଆଉ ପସନ୍ଦ କରନ୍ତି ନାହିଁ ।

SubQuestion No : 140

Q.140 ଅନୁ ଚ୍ଛେଦର ପ୍ରଧାନ ଉଦ୍ଦେଶ୍ୟ କ’ଣ ?

Ans 1. ପ୍ରାକୃତିକ ଦୁର୍ଘଟଣା

2. ସମାଜର ମନୋରଞ୍ଜନ

3. ମଣିଷର ଚିନ୍ତା ଧାରା ସମାଜକୁ  ପ୍ରଭାବିତ କରିବା

4. ବୈଜ୍ଞାନିକ ଆବିଷ୍କାର

Question Type : MCQ

Question ID : 4410091739106

Option 1 ID : 4410096858029

Option 2 ID : 4410096858027

Option 3 ID : 4410096858030

Option 4 ID : 4410096858028

Status : Answered

Chosen Option : 3

Section : Computer
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Q.141 What is the keyboard shortcut to begin editing text within a selected text box in
PowerPoint (Microsoft Office 2021)?

Ans 1. F1

2. F11

3. F2

4. F8

Question Type : MCQ

Question ID : 441009937115

Option 1 ID : 4410093702207

Option 2 ID : 4410093702210

Option 3 ID : 4410093702208

Option 4 ID : 4410093702209

Status : Answered

Chosen Option : 3

Q.142 Identify the command to start a presentation in Presenter View in MS PowerPoint.

Ans 1. Alt+F5

2. Shift+F5

3. F5

4. Ctrl+H

Question Type : MCQ

Question ID : 441009992295

Option 1 ID : 4410093921322

Option 2 ID : 4410093921321

Option 3 ID : 4410093921320

Option 4 ID : 4410093921323

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.143 Which of the following procedures accurately sets a new font and size as the default
for all new documents created in MS-Word, without requiring the user to apply
styles or open templates manually each time?

Ans 1. Click the Design tab → Select 'Fonts' → Create a New Theme Font with desired font

settings → Save and apply the new theme globally

2. Right-click any selected text → Choose 'Font…' → Change font and size → Click OK

3. Go to the Home tab → Click the small launcher arrow in the Font group → Choose desired

font and size → Click 'Set As Default' → Select 'All documents based on Normal template' → Click
OK

4. Highlight text → Use the Font group to set desired font and size → Save the file as a new
Word Template (.dotx) and manually use it each time a new document is needed

Question Type : MCQ

Question ID : 441009940067

Option 1 ID : 4410093713905

Option 2 ID : 4410093713906

Option 3 ID : 4410093713904

Option 4 ID : 4410093713907

Status : Answered

Chosen Option : 3

Q.144 What is the first step to create a list from existing text in Microsoft Word?

Ans 1. Open the 'View' tab

2. Click 'Save As'

3. Select the text you want to change into a list

4. Press Ctrl + Enter

Question Type : MCQ

Question ID : 441009941208

Option 1 ID : 4410093718492

Option 2 ID : 4410093718491

Option 3 ID : 4410093718490

Option 4 ID : 4410093718489

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
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Q.145 Which shortcut key is used to paste copied content?

Ans 1. Ctrl + F

2. Ctrl + V

3. Ctrl + S

4. Ctrl + C

Question Type : MCQ

Question ID : 44100989965

Option 1 ID : 441009358021

Option 2 ID : 441009358019

Option 3 ID : 441009358018

Option 4 ID : 441009358020

Status : Answered

Chosen Option : 2

Q.146 Which of the following is a valid method to insert a new column in MS-Excel 2021?

Ans 1. Select any cell in the row → Go to Data tab → Click Sort A to Z

2. Select a cell in the column → Go to Home tab → Click Insert → Choose Insert Sheet

Columns

3. Press F1 while the column is selected to open the Insert dialog box

4. Click the bottom-right corner of a cell → Drag the fill handle upward

Question Type : MCQ

Question ID : 441009979948

Option 1 ID : 4410093872303

Option 2 ID : 4410093872302

Option 3 ID : 4410093872305

Option 4 ID : 4410093872304

Status : Not Answered

Chosen Option : --

Q.147 What does the shortcut Ctrl + B do in MS Word?

Ans 1. Copies the text

2. Changes font color

3. Makes text italic

4. Bolds the selected text

Question Type : MCQ

Question ID : 441009925404

Option 1 ID : 4410093655743

Option 2 ID : 4410093655744

Option 3 ID : 4410093655741

Option 4 ID : 4410093655742

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.148 Which of the following is not a standard component of an e-mail’s structure?

Ans 1. Subject line

2. Sender’s address

3. Operating System version

4. Attachment option

Question Type : MCQ

Question ID : 4410091211474

Option 1 ID : 4410094779394

Option 2 ID : 4410094779395

Option 3 ID : 4410094779397

Option 4 ID : 4410094779396

Status : Answered

Chosen Option : 3

Q.149 Which transmission media is commonly used in WAN for long-distance
communication?

Ans 1. HDMI cables

2. Unshielded twisted pair

3. Infrared waves

4. Fibre optic cables

Question Type : MCQ

Question ID : 441009939454

Option 1 ID : 4410093711475

Option 2 ID : 4410093711473

Option 3 ID : 4410093711476

Option 4 ID : 4410093711474

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.150 When editing a presentation, you paste text from MS Word into an MS PowerPoint
2019 slide. Which paste option retains the PowerPoint theme’s font and formatting
rather than Word’s?

Ans 1. Keep Text Only

2. Merge Formatting

3. Use Destination Theme

4. Keep Source Formatting

Question Type : MCQ

Question ID : 4410091203603

Option 1 ID : 4410094747920

Option 2 ID : 4410094747918

Option 3 ID : 4410094747919

Option 4 ID : 4410094747917

Status : Not Answered

Chosen Option : --

Q.151 What does the keyboard shortcut Ctrl + V do?

Ans 1. Copies the selected item

2. Views file properties

3. Cuts the selected item

4. Pastes the selected item

Question Type : MCQ

Question ID : 441009302992

Option 1 ID : 4410091178562

Option 2 ID : 4410091178563

Option 3 ID : 4410091178560

Option 4 ID : 4410091178561

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
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Q.152 In Microsoft Word, which keyboard shortcut is used to copy selected text?

Ans 1. Ctrl + Z

2. Ctrl + X

3. Ctrl + C

4. Ctrl + V

Question Type : MCQ

Question ID : 441009941747

Option 1 ID : 4410093720651

Option 2 ID : 4410093720648

Option 3 ID : 4410093720650

Option 4 ID : 4410093720649

Status : Answered

Chosen Option : 3

Q.153 Which menu in Microsoft PowerPoint is used to insert sound or movie clips into a
presentation?

Ans 1. File

2. View

3. Tools

4. Insert

Question Type : MCQ

Question ID : 441009930339

Option 1 ID : 4410093675224

Option 2 ID : 4410093675225

Option 3 ID : 4410093675223

Option 4 ID : 4410093675222

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.154 Which Windows feature best helps a government office
organize and access a large volume of documents easily for
non-technical staff?

Ans 1. File Explorer with Quick Access and Libraries

2. Control Panel for system settings

3. Command Prompt for manual file management

4. Third-party tools for file management

Question Type : MCQ

Question ID : 441009465447

Option 1 ID : 4410091820364

Option 2 ID : 4410091820366

Option 3 ID : 4410091820365

Option 4 ID : 4410091820367

Status : Not Answered

Chosen Option : --

Q.155 Expand the abbreviation BIOS.

Ans 1. Basic Interface Output System

2. Build Input Output Sample

3. Basic Input/Output System

4. Build Input/Output Structure

Question Type : MCQ

Question ID : 441009928935

Option 1 ID : 4410093669711

Option 2 ID : 4410093669710

Option 3 ID : 4410093669709

Option 4 ID : 4410093669712

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.156 How can you quickly increase font size in MS Word 2021 without using the font size
dropdown?

Ans 1. Ctrl + B

2. Ctrl + Shift + <

3. Ctrl + I

4. Ctrl + Shift + >

Question Type : MCQ

Question ID : 441009383557

Option 1 ID : 4410091499822

Option 2 ID : 4410091499820

Option 3 ID : 4410091499823

Option 4 ID : 4410091499821

Status : Answered

Chosen Option : 4

Q.157 Which of the following actions will NOT start Edit mode in MS Excel 2021?

Ans 1. Pressing Ctrl + E while the cell is selected

2. Selecting the cell and pressing the F2 key

3. Double-clicking directly on the cell you want to edit

4. Selecting the cell and clicking in the formula bar

Question Type : MCQ

Question ID : 441009977657

Option 1 ID : 4410093863377

Option 2 ID : 4410093863376

Option 3 ID : 4410093863374

Option 4 ID : 4410093863375

Status : Answered

Chosen Option : 1

https://applink.adda247.com/d/uHd24maK7j
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Q.158 Identify the file types which are created when we save a complete web page using
Ctrl+S in Chrome.

Ans 1. .html and a folder with assets

2. .html and .http

3. .zip with all files inside

4. .docx and .png

Question Type : MCQ

Question ID : 441009338380

Option 1 ID : 4410091319486

Option 2 ID : 4410091319484

Option 3 ID : 4410091319487

Option 4 ID : 4410091319485

Status : Answered

Chosen Option : 4

Q.159 Identify the recent world wide web version from the following.

Ans 1. Web 3.0

2. Web 5.0

3. Web 4.0

4. Web 2.0

Question Type : MCQ

Question ID : 441009948141

Option 1 ID : 4410093746066

Option 2 ID : 4410093746067

Option 3 ID : 4410093746065

Option 4 ID : 4410093746068

Status : Not Answered

Chosen Option : --

https://applink.adda247.com/d/uHd24maK7j
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Q.160 Which of the following shortcut keys is used to display the Save As dialog box in
MS-Excel Workbook?

Ans 1. F12

2. F7

3. F11

4. F1

Question Type : MCQ

Question ID : 441009970639

Option 1 ID : 4410093835681

Option 2 ID : 4410093835682

Option 3 ID : 4410093835680

Option 4 ID : 4410093835679

Status : Answered

Chosen Option : 1

Q.161 Which of the following best describes a web browser?

Ans 1. Linux

2. A file management system

3. A software used to design websites

4. A tool to access and navigate the Internet and WWW

Question Type : MCQ

Question ID : 4410091387714

Option 1 ID : 4410095481533

Option 2 ID : 4410095481532

Option 3 ID : 4410095481530

Option 4 ID : 4410095481531

Status : Answered

Chosen Option : 4

Q.162 What is the effect of pressing the F2 key while a cell is selected in Excel?

Ans 1. It opens the help window

2. It deletes the content in the cell

3. It enters formula mode

4. It allows editing inside the cell

Question Type : MCQ

Question ID : 441009966005

Option 1 ID : 4410093817236

Option 2 ID : 4410093817234

Option 3 ID : 4410093817235

Option 4 ID : 4410093817237

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j


Q.163 What does a Wide Area Network (WAN) typically connect?

Ans 1. Devices connected without cables

2. Only mobile phones in one area

3. Devices within one room only

4. Computers in different cities or countries

Question Type : MCQ

Question ID : 441009966160

Option 1 ID : 4410093817850

Option 2 ID : 4410093817851

Option 3 ID : 4410093817848

Option 4 ID : 4410093817849

Status : Answered

Chosen Option : 4

Q.164 How do you apply word wrapping to a text box in MS PowerPoint?

Ans 1. There is no option to wrap text in PowerPoint.

2. Use the Wrap Text button in the Home tab

3. Right-click the text box and choose Wrap Text

4. Text automatically wraps in the text box when the box is resized

Question Type : MCQ

Question ID : 441009924209

Option 1 ID : 4410093650995

Option 2 ID : 4410093650993

Option 3 ID : 4410093650992

Option 4 ID : 4410093650994

Status : Not Answered

Chosen Option : --

Q.165 Which of the following is the property of orientation of a page in MS-Word 2019?

Ans 1. Right margin

2. Top

3. Landscape

4. Bottom

Question Type : MCQ

Question ID : 441009963409

Option 1 ID : 4410093806977

Option 2 ID : 4410093806974

Option 3 ID : 4410093806975

Option 4 ID : 4410093806976

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.166 What is the full form of GUI?

Ans 1. Graphical User Interface

2. Graphical Unit Interchange

3. Graphical Unit Interface

4. Graphical Universal Interface

Question Type : MCQ

Question ID : 441009929036

Option 1 ID : 4410093670109

Option 2 ID : 4410093670108

Option 3 ID : 4410093670110

Option 4 ID : 4410093670111

Status : Answered

Chosen Option : 1

Q.167 What happens to the computer when it is put into Sleep mode in Windows 11
Operating System?

Ans 1. The system enters a low-power state, keeping all work and applications ready in the RAM.

2. The display is turned off, but the CPU continues to run at full speed.

3. All open programs and files are saved to the hard disk, and the system is powered off
completely.

4. The computer completely shuts down and restarts the operating system instantly when
turned on.

Question Type : MCQ

Question ID : 4410091544012

Option 1 ID : 4410096099149

Option 2 ID : 4410096099150

Option 3 ID : 4410096099148

Option 4 ID : 4410096099147

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Q.168 In printing one or several workbooks in MS Excel, which keyboard key is held down
and then clicked on the name of each workbook to print, and then Print is selected?

Ans 1. Ctrl

2. Tab

3. Alt

4. Shift

Question Type : MCQ

Question ID : 441009970629

Option 1 ID : 4410093835639

Option 2 ID : 4410093835642

Option 3 ID : 4410093835640

Option 4 ID : 4410093835641

Status : Answered

Chosen Option : 3

Q.169 To enter data on a new line within a cell in MS Excel, enter a line break by pressing
___________.

Ans 1. CRTL+ENTER

2. ALT+ENTER

3. ALT+F2

4. CTRL+ALT+TAB

Question Type : MCQ

Question ID : 441009975222

Option 1 ID : 4410093853913

Option 2 ID : 4410093853915

Option 3 ID : 4410093853914

Option 4 ID : 4410093853916

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Q.170 Which built-in Windows tool helps protect the system
from malware and viruses?

Ans 1. Windows Applications

2. Windows Defender Firewall

3. Disk Cleanup

4. Task Manager

Question Type : MCQ

Question ID : 441009486526

Option 1 ID : 4410091901477

Option 2 ID : 4410091901478

Option 3 ID : 4410091901480

Option 4 ID : 4410091901479

Status : Answered

Chosen Option : 2

Q.171 When a user manually drags a vertical border line within a Microsoft Word 2016
table, what dimension are they primarily adjusting?

Ans 1. The table position on the page

2. The width of the column

3. The cell vertical alignment

4. The height of the row

Question Type : MCQ

Question ID : 441009851181

Option 1 ID : 4410093357695

Option 2 ID : 4410093357694

Option 3 ID : 4410093357696

Option 4 ID : 4410093357693

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Q.172 Which of the following statements correctly distinguishes between a slide transition
and an animation in MS PowerPoint 2021?

Ans 1. Transitions are applied only to text placeholders; animations are used exclusively for
multimedia content like videos or audio.

2. Transitions determine the text font and color of each slide; animations adjust the slide
layout and theme design.

3. Transitions trigger sound effects between slides; animations automatically advance the
entire presentation without user input.

4. Transitions control how the presentation moves from one slide to the next; animations
manage how individual objects appear, move, or disappear within a single slide.

Question Type : MCQ

Question ID : 441009994679

Option 1 ID : 4410093930783

Option 2 ID : 4410093930784

Option 3 ID : 4410093930785

Option 4 ID : 4410093930782

Status : Answered

Chosen Option : 4

Q.173 For applying superscript while working in MS-PowerPoint, which of the following
keyboard shortcuts is used?

Ans 1. Press Ctrl and the Equal sign (=) at the same time.

2. Press Ctrl and the Minus sign (-) at the same time.

3. Press Ctrl, Shift, and the Plus sign (+) at the same time.

4. Press Ctrl and the Plus sign (+) at the same time.

Question Type : MCQ

Question ID : 441009975353

Option 1 ID : 4410093854437

Option 2 ID : 4410093854439

Option 3 ID : 4410093854440

Option 4 ID : 4410093854438

Status : Answered

Chosen Option : 3

https://applink.adda247.com/d/uHd24maK7j
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Q.174 Which of the following is the best example of a Wide Area Network (WAN)?

Ans 1. Office intranet

2. Internet

3. Home Wi-Fi

4. School network

Question Type : MCQ

Question ID : 441009910327

Option 1 ID : 4410093595451

Option 2 ID : 4410093595454

Option 3 ID : 4410093595453

Option 4 ID : 4410093595452

Status : Answered

Chosen Option : 2

Q.175 Which of the following cell references in Excel remains constant when copied across
rows or columns in a formula?

Ans 1. A1

2. A$1

3. $A1

4. $A$1

Question Type : MCQ

Question ID : 441009965560

Option 1 ID : 4410093815484

Option 2 ID : 4410093815485

Option 3 ID : 4410093815487

Option 4 ID : 4410093815486

Status : Not Answered

Chosen Option : --

https://applink.adda247.com/d/uHd24maK7j
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Q.176 If you want to view the MS PowerPoint slides in full-screen mode without
animations, which view should you use?

Ans 1. Outline View

2. Slide Show View

3. Reading View

4. Presenter View

Question Type : MCQ

Question ID : 441009924170

Option 1 ID : 4410093650842

Option 2 ID : 4410093650840

Option 3 ID : 4410093650841

Option 4 ID : 4410093650843

Status : Answered

Chosen Option : 2

Q.177 How many computers can typically be connected in a LAN?

Ans 1. Only one computer

2. Limited number

3. Unlimited number

4. Millions of computers globally

Question Type : MCQ

Question ID : 441009963441

Option 1 ID : 4410093807100

Option 2 ID : 4410093807099

Option 3 ID : 4410093807098

Option 4 ID : 4410093807101

Status : Answered

Chosen Option : 2

https://applink.adda247.com/d/uHd24maK7j
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Q.178 On the Home tab of the Ribbon in Microsoft Word 2016, which group of icons is
used to change text attributes like Bold, Italic and Underline?

Ans 1. Clipboard

2. Font

3. Paragraph

4. Styles

Question Type : MCQ

Question ID : 441009851278

Option 1 ID : 4410093358087

Option 2 ID : 4410093358084

Option 3 ID : 4410093358086

Option 4 ID : 4410093358085
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Q.179 Which of the following is the correct extension for the Text File format used in MS
Excel 2013?

Ans 1. .xls

2. .xlsx

3. .xml

4. .csv
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Q.180 In Windows, which component primarily provides the graphical user interface that
displays the desktop, taskbar, and Start Menu?

Ans 1. Local Security Policy

2. Windows Registry

3. Windows Explorer / File Explorer shell

4. Device Manager
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Question ID : 4410091555877

Option 1 ID : 4410096146063

Option 2 ID : 4410096146061

Option 3 ID : 4410096146064

Option 4 ID : 4410096146062

Status : Answered

Chosen Option : 4

https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j
https://applink.adda247.com/d/uHd24maK7j

